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Part 1
Workcell Item



1. Workcell Item Summary

Workcell Item refers to the robot and all peripherals used together with the robot.

Workcell items can be configured in the Workcell Manager screen before use. Also, the Workcell
Manager can set commands for peripherals and can configure commands for the robot to perform
certain patterns and actions.

The combination of skills available change according to the configured Workcell Items, and in certain
conditions, the Task Builder can recommend a suitable task template.

This manual describes the Workcell Item Setting options in the Workcell Manager for the end effector,
machine and peripherals.

Item Description

End effectors can be added to the robot, and the added end effector
End Effector

is displayed.
. Machines compatible with the robot can be added, and the added
Machine .
machine is displayed.
. Peripherals connected to the robot can be added, and the added
Peripherals . L
peripheral is displayed.
1.1 Workcell ltem Common Setting Options

Common setting options for Workcell items are as follows:

Item Description

Output Signal It selects the output signal type.

Input Signal It selects the input signal type.




2. End Effector
2.1 Gripper (Gripper)

There are the Pneumatic Gripper, Vacuum Gripper and Electric Gripper, and gripper setting options
are as follows:

Grasp It configures the output signal for grasping the target.

Release It configures the output signal for releasing the target.

It configures an input signal that checks whether the

Gripper Close Sensor . . - . .
PP grasping of the target is complete. This item is optional.

It configures an input signal that checks whether the

Gripper Open Sensor . . . . .
PP P releasing of the target is complete. This item is optional.

2.1.1 Pneumatic Gripper (Pneumatic Gripper)

It is a gripper that uses pneumatic pressure supplied externally. It features a finger that allows it to
grasp or release an object according to the digital signal it receives. It is connected to a pneumatic
pressure control device where it opens and closes according to signals. In general, it is connected to a
double-action pneumatic pressure control device.

2.1.2 Vacuum Gripper (Vacuum Gripper)

It is a gripper that uses an externally supplied vacuum. It features a vacuum pad connected to an
external vacuum generator, and it opens and closes according to digital signals from the vacuum
generator. In general, it is connected to a double-action pneumatic pressure control device.

2.1.3 Electric Gripper

It is a gripper operated with electric power supplied by the robot or an external power source. It
features a Finger that allows it to grasp or release an object according to the digital signal it receives.

2.2 Screwdriver

It is a tool that tightens bolts with power supplied externally. The tool operates when a signal is
received, and it does not operate when a signal is not received. If the tool features an auto tightening
torque check function, the successful tightening status is delivered via electrical signals.

Screw ‘ It configures the signal that operates the screwdriver tool.




The tool operates when a signal is received, and it does not
operate when a signal is not received.

Configures the counter-rotation mode signal of tools that

Counter-Rotation Mode support counter-rotation mode with external signals.

Configures the vacuum on signal for picking up a screw
Vacuum On when a screw is supplied from an external feeder, if a
separate vacuum tool is installed.

Configures the vacuum off signal for picking up a screw
Vacuum Off when a screw is supplied from an external feeder, if a
separate vacuum tool is installed.

It configures the input signal of the tightening torque OK
Torque OK status if the tool features an auto tightening torque check
function.

It configures the input signal of the tightening torque NG
Torque NG status if the tool features an auto tightening torque check
function.

2.3 Gluing Tool

It is a device mounted on the end of a robot. It discharges liquid at a desired location or in a specific
linear shape using hydraulic or pneumatic pressure. The robot installed with the tool is capable of
smoothly moving along the shape the user configured.

Description

It configures the signal that operates the Gluing tool. The
Glue tool operates when a signal is received, and it does not
operate when a signal is not received.

2.4 Deburring Tool

This is a device mounted on the end of a robot. It is a device that removes burrs on products using a
cutting blade or brush mounted on the end of a device rotated with hydraulic or pneumatic pressure, or
electric power. The robot installed with the tool is capable of smoothly moving along the shape the
user configured (i.e. product edges).

Description

It configures the signal that operates the Deburring tool.
Deburr The tool operates when a signal is received, and it does not
operate when a signal is not received.

2.5 Airblow Nozzle
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It is a device attached to the robot end, and it is installed next to the gripper where it removes chips
using pneumatic pressure during machining support and cleaning work.

Description

It configures the signal that operates the airblow tool. The
Air Blow tool operates when a signal is received, and it does not
operate when a signal is not received.

2.6 Polish

This is a device mounted on the end of a robot. It is a device that polishes the surfaces of products
using a brush mounted on the end of a device rotated with hydraulic or pneumatic pressure, or electric

power. The robot with the tool installed is capable of moving smoothly along the shape the user has
configured (i.e., the product surface).

Description

It configures the signal that operates the Polishing tool. The
Polish tool operates when a signal is received, and it does not
operate when a signal is not received.

Doosan Robotics Reference Manual v1.4 14



3. Machine

3.1 Press Machine (Press Machine)

A press machine is generally a device that compresses a flat material to form desired shapes. After the
material is placed in the press machine and pressed, the robot removes the workpiece and places it in

a designated location.

Item Description

Press

It configures the output signal for starting the press
machine.

Machine Operation
Preparation Sensor

It configures the input signal for authorizing press machine
operation.

3.2 Turning Center (Turning Center)

It is a type of machine tool that turns cylindrical material to allow the material to be cut to the desired
form using a tool turret. Once the machining of the material placed in the machine tool is complete, the

robot removes the workpiece and places it on a pallet or in a designated location.

Item Description

Machine Operation

It configures the output signal for starting the machine tool.

Open Chuck It configures the output signal for grasping the target.
Close Chuck It configures the output signal for releasing the target.
It configures the output signal for closing the door of the
Open door .
machine tool.
It configures the output signal for opening the door of the
Close door g putsig P g

machine tool.

Reset Machine

It configures the output signal for the robot connection
initialization signal sent to the machine tool.

Robot Online

It configures the output signal for resetting the machine
tool.

Wash Workpiece

It configures the output signal for operating the airblow
device installed on the machine tool to clean the workpiece.

Tailstock Forward

It configures the output signal for moving the machine tool
tailstock forward.

Tailstock Retreat

It configures the output signal for moving the machine tool
tailstock backward.

Open Steady Rest

It configures the output signal for opening the steady rest.




Close Steady Rest It configures the output signal for closing the steady rest.

It configures the input signal for authorizing the machine

Approach Authorization .
tool operation.

It configures the input signal to check whether the chuck is

Chuck Open Check
properly closed.

It configures the input signal to check whether the chuck is

Chuck Close Check
properly opened.

It configures the input signal to check whether the door is

Door Open Check
properly closed.

It configures the input signal to check whether the door is

Door Close Check
properly opened.

It configures the input signal to check whether the airblow
device installed on the machine tool completed its
operation.

Workpiece Wash Completion
Check

It configures the input signal to check whether the tailstock

Tailstock Forward Check .
forward movement is complete.

It configures the input signal to check whether the tailstock

Tailstock Retreat Check .
backward movement is complete.

It configures the input signal to check whether the steady

Steady Rest Open Check .
rest is opened.

It configures the input signal to check whether the steady

Steady Rest Close Check .
rest is closed.

3.3 Injection Molding Machine (Injection Molding Machine)

The injection molding machine is a device that molds shapes by injecting materials such as plastic into
a mold. The robot removes the molded workpiece from the injection molding machine and places it in
a designated location.

Item Description

It configures the output signal for starting the injection

Machine Operation molding machine.

Machine Operation It configures the input signal for authorizing injection
Preparation Sensor molding machine operation.
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4.
4.1

4.2

Peripherals

Pallet

Itis a type of cradle that allows the target to be placed in a set formation. All targets on a pallet can be
handled with minimum instructions. It is the Workcell item for pallets with a square grid pattern.

It supports four order patterns as shown in the figure below, so the user can select a pattern as
needed.

Pallet Row & Column

Row | 4 Column | 3 n

Pallet Pattern T
o o—8

M =

| ] [+—] —

Pallet (Stack)

It is the Workcell item for pallets with grid type patterns, and after entering the row and column values
along with the stack and thickness, it automatically stacks the target or recommends a skill suited for
picking and moving the target.

It supports four order patterns as shown in the figure below, so the user can select a pattern as
needed.

Pallet Row & Column

Row 4 Column 3 n

|
H—a

Stack 1 Thickness 0 mm

Pallet Pattern
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+ To automatically calculate the offset direction of stacked or picked items according to the pallet's
upward/downward direction, it is recommended that the Workcell item’s three points be instructed
in a counter-clockwise direction on a guide image.

4.3 Pallet (Rhombus)

It is the Workcell item for pallets with intersecting rhombus patterns, and after entering the row and
column values based on the pallet position and skill used for single stacks, along with the stack and
thickness, it automatically stacks the target or recommends a skill suited for picking and moving the

target.

It supports four order patterns as shown in the figure below, so the user can select a pattern as

needed.

Pallet Row & Column

Row 4 Column

Stack 1 Thickness

Pallet Pattern

[ ]

it

I Note

= W

©

mir

o——o

=

To automatically calculate the offset direction of stacked or picked items according to the
pallet’s upward/downward direction, it is recommended that the Workcell item’s three points be
instructed in a counter-clockwise direction on a guide image.
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4.4 Line Pattern

It is the Workcell item for target batches with linear patterns, and after entering the number of targets
on a linear pattern and skill used for single stacks, along with the stack and thickness, it automatically
stacks the target or recommends a skill suited for picking and moving the target.

Line Pattern

Count 2

Stack 1 Thickness 0 mm n a

4.5 Shooting Bolt Feeder

It is a type of feeder that feeds a bolt through a tube from the screw assembly to the screwdriver end.
If a sensor is installed, it checks whether a bolt is prepared before feeding it to the screwdriver end.

Item Description

Bolt Shooting It configures the bolt shooting signal.

It selects the input signal to check whether a bolt is

Bolt Preparation Sensor
P prepared at the bolt feeder.

4.6 Pick-up Bold Feeder

It is a type of feeder that feeds bolts to the system from the screw assembly, and the robot must pick
up the bolt. If a sensor is installed, it sends a signal to the robot indicating whether a bolt is ready.

It selects the input signal to check whether a bolt is

Bolt Preparation Sensor
P prepared at the bolt feeder.
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5. Additional Workcell Items

5.1 Common Setting Options

Additional common setting options for Workcell items are as follows:

Item Description

Output Signal It selects the output signal type.
Input Signal It selects the input signal type.
5.2 Additional Workcell Item List

521 Schmalz - FXCB

Item Description

There are two methods of creating a vacuum according to
each FXCB model.

T - Normally Open: Vacuum is created when the power
ype supply is off or if the Suction On/Off Signal is off.

- Normally Closed: Vacuum is created when the Suction
On/Off Signal is on.

Port Number Configures the port number of the output signal.

Outputs a signal to test a motion through the port number

Motion i .
configured for the output signal.

Suction On/Off It selects the input signal type.

It configures an input signal that checks whether the

Vent On/Off . . . . .
grasping of the target is performed. This item is optional.

Checks the gripper close input signal configured by the port

Gripper Close Sensor
'bP number of the configured input signal.

The following skills and commands can be used in conjunction with this Workcell item.

e« Grasp

* Release
 Pick

+ Place

+  Pick Pallet

* Place Pallet



. Insert

5.2.2 Shumalz - CobotPump

Item Description

Grasp It configures the output signal for grasping the target.

Release It configures the output signal for releasing the target.

It configures an input signal that checks whether the

Gripper Close Sensor . . . . .
PP grasping of the target is performed. This item is optional.

It configures an input signal that checks whether the

Gripper Open Sensor . . - . .
PP P releasing of the target is performed. This item is optional.

The following skills and commands can be used in conjunction with this Workcell item.

e« Grasp

* Release

« Pick

* Place

«  Pick Pallet

+ Place Pallet

. Insert

5.2.3 Shunk - MPG

Item Description

Grasp It configures the output signal for grasping the target.

Release It configures the output signal for releasing the target.

It configures an input signal that checks whether the

Gripper Close Sensor . . . . .
PP grasping of the target is performed. This item is optional.

It configures an input signal that checks whether the

Gripper Open Sensor
'bP P releasing of the target is performed. This item is optional.

The following skills and commands can be used in conjunction with this Workcell item.

e Grasp

* Release
+ Pick

* Place

21



*  Pick Pallet
* Place Pallet

. Insert

5.2.4 Shunk - Co-act

Grasp It configures the output signal for grasping the target.
Release It configures the output signal for releasing the target.
End Pressing this button will end the gripper.

Pressing the button lights up the LED according to the
error.

Error Correction

It configures an input signal that checks whether the

Gripper Close Sensor . . o . .
PP grasping of the target is performed. This item is optional.

It configures an input signal that checks whether the

Gripper Open Sensor . . . . .
PP P releasing of the target is performed. This item is optional.

The following list contains skills and commands that can be used in conjunction with this Workcell item.

« Grasp

* Release

« Pick

« Place

«  Pick Pallet

» Place Pallet

. Insert

5.25 Zimmer - GEP2000

Grasp It configures the output signal for grasping the target.

Release It configures the output signal for releasing the target.

This configures an input signal that checks the position
value detected based on two values entered in the gripper

Position Check
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setting. This item is optional.

The following list contains skills and commands that can be used in conjunction with this Workcell item.

 Grasp

* Release

« Pick

* Place

«  Pick Pallet

* Place Pallet

. Insert

526 Zimmer - HCRO03

It selects the predefined Modbus address. The IP address
and name configured by the user for the Modbus slave
Modbus Address equipment are displayed. To add new items, go to Setting
> Network > Predefined Modbus menu, and configure
them.

Equipment is connected to the selected Modbus address,

Load . . .
and the buttons used to test gripper motion are activated.
Gripper Setting Motions for gripper setting are performed.
It sends an initialization signal to the gripper to perform
Initialize 9 gripperfo p

gripper initialization.

The gripper position when the corresponding workpiece is
Teaching Pose grasped. It can be configured from a minimum of 0.00 mm
to a maximum of 20.00 mm.

This is the teaching pose allowance deviation. It can be
Allowance configured from a minimum of 0.00 mm to a maximum of
2.55 mm.

This is the force the gripper applies to grasp an item. It can

Force be configured from Lv1 up to Lv4.

This is the pose when the gripper grasps an item. Select

Device M . .
evice Mode one from inward, outward and universal.

This is the area displaying the current position measured

Actual Position by the gripper’s grasp/release motion tests.

Grasp Performs tests for grasping a target item.
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Release Performs tests for releasing a target item.

A new workpiece can be added. Up to 32 workpieces can

Add New Workpiece be added.

This is the input signal for the gripper’s status code. The
following are the meanings of each status code.

0x06: Gripper PLC Active, 0x08: Base Position, 0x09:
Teach Position, Ox0a: Work Position, 0x0Ob: Undefined
Position, 0x0c: Data transfer ok, 0x0d: ControlWord 0x100,
0x0e: ControlWord 0x200, 0xO0f: Error

Gripper Status

Diagnosis This is the input signal for the gripper’s diagnosis code.

The following list contains skills and commands that can be used in conjunction with this Workcell item.

« Grasp

* Release
 Pick

* Place

«  Pick Pallet

* Place Pallet

. Insert

5.2.7 Robotiq - 2F-85

Item Description

It selects the predefined Modbus address. The IP address
and name configured by the user for the Modbus slave
equipment are displayed. To add new items, go to Setting
> Network > Predefined Modbus menu, and configure.

Modbus Address

Equipment is connected to the selected Modbus address,

Connect and buttons used to test gripper motion are activated.

It selects the gripper’s release option during a robot
undergoing emergency stop. The definition of each option
is as follows:

Auto Release Option Auto Release Close: Gripper closes at maximum upon
robot emergency stop

Auto Release Open: Gripper opens at maximum upon
robot emergency stop.

Gripper Setting Motions for gripper setting are performed.
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It sends an initialization signal to the gripper to perform

Initialize . S
gripper initialization.
Gras The gripper position when the corresponding workpiece is
P grasped.
The gripper position when the correspondi kpi i
Release gripper p ponding workpiece is
released.
Velocity Gripper movement speed.
Force The gripper’s force.

Current Position

It is the area displaying the current position measured
through the gripper’s grasp/release motion tests.

Grasp

Performs tests for grasping a target item.

Release

Performs tests for releasing a target item.

Add New Motion

A new motion can be added. Up to eight motions can be
added.

Grasp Status Sensing

This is the input signal for the gripper’s status.

Fault Status Sensing

This is the input signal for the gripper’s error status.

Requested Position Sensing

This is the input signal for the position value sent to the
gripper.

Current Position Sensing

This is the input signal for the current position of the
gripper.

Current Sensing

This is the input signal for the current current value of the
gripper.

The following list contains skills and commands that can be used in conjunction with this Workcell item.

e« Grasp

* Release

*  Pick

« Place

+  Pick Pallet

» Place Pallet

. Insert

5.2.8 Robotiq - 2F-140
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Modbus Address

It selects the predefined Modbus address. The IP address
and name configured by the user for the Modbus slave
equipment are displayed. To add new items, go to Setting
> Network > Predefined Modbus menu, and configure.

Connect

Equipment is connected to the selected Modbus address,
and buttons used to test gripper motion are activated.

Auto Release Option

It selects the gripper’s release option during a robot
undergoing emergency stop. The definition of each option
is as follows:

Auto Release Close: Gripper closes at maximum upon
robot emergency stop

Auto Release Open: Gripper opens at maximum upon
robot emergency stop.

Gripper Setting

Motions for gripper setting are performed.

It sends an initialization signal to the gripper to perform

Initialize . S
gripper initialization.
Gras The gripper position when the corresponding workpiece is
P grasped.
The gri iti hen th i kpi i
Release gripper position when the corresponding workpiece is
released.
Velocity Gripper movement speed.
Force The gripper’s force.

Current Position

It is the area displaying the current position measured
through the gripper’s grasp/release motion tests.

Grasp

Performs tests for grasping a target item.

Release

Performs tests for releasing a target item.

Add New Motion

A new motion can be added. Up to eight motions can be
added.

Grasp Status Sensing

This is the input signal for the gripper’s status.

Fault Status Sensing

This is the input signal for the gripper’s error status.

Requested Position Sensing

This is the input signal for the position value sent to the
gripper.

Current Position Sensing

This is the input signal for the current position of the
gripper.

Current Sensing

This is the input signal for the current current value of the
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gripper.

The following list contains skills and commands that can be used in conjunction with this Workcell item.
Refer to each skill’'s manual for the operation of each skill.

 Grasp

* Release

« Pick

* Place

«  Pick Pallet

+ Place Pallet

. Insert

5.2.9 Robotiq - Hand-E

It selects the predefined Modbus address. The IP address
and name configured by the user for the Modbus slave
equipment are displayed. To add new items, go to Setting
> Network > Predefined Modbus menu, and configure.

Modbus Address

Equipment is connected to the selected Modbus address,

Connect and buttons used to test gripper motion are activated.

It selects the gripper’s release option during a robot
undergoing emergency stop. The definition of each option
is as follows:

Auto Release Option Auto Release Close: Gripper closes at maximum upon
robot emergency stop

Auto Release Open: Gripper opens at maximum upon
robot emergency stop.

Gripper Setting Motions for gripper setting are performed.

It sends an initialization signal to the gripper to perform

Initialize . T
gripper initialization.

The gripper position when the corresponding workpiece is

Grasp grasped.

The gripper position when the corresponding workpiece is

Release
released.

Velocity Gripper movement speed.

Force The gripper’s force.
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It is the area displaying the current position measured

Current Position
through the gripper’s grasp/release motion tests.

Grasp Performs tests for grasping a target item.

Release Performs tests for releasing a target item.

. A new motion can be added. Up to eight motions can be
Add New Motion

added.
Grasp Status Sensing This is the input signal for the gripper’s status.
Fault Status Sensing This is the input signal for the gripper’s error status.

This is the input signal for the position value sent to the

Requested Position Sensing .
gripper.

This is the input signal for the current position of the

Current Position Sensing .
gripper.

This is the input signal for the current current value of the

Current Sensing )
gripper.

The following list contains skills and commands that can be used in conjunction with this Workcell item.

« Grasp

* Release

« Pick

« Place

«  Pick Pallet

* Place Pallet

. Insert

5.2.10 Robotiq - 3-Finger

Item Description

It selects the predefined Modbus address. The IP address
and name configured by the user for the Modbus slave
equipment are displayed. To add new items, go to Setting
> Network > Predefined Modbus menu, and configure.

Modbus Address

Equipment is connected to the selected Modbus address,

Connect and buttons used to test gripper motion are activated.

Gripper Setting Motions for gripper setting are performed.
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It sends an initialization signal to the gripper to perform

Initialize . S
gripper initialization.
Gras The gripper position when the corresponding workpiece is
P grasped.
The gripper position when the corresponding workpiece is
Release gripper p p 9 p
released.
Mode Selects the gripper’s operation mode. Select one from
Basic Mode, Pinch Mode, Wide Mode and Scissor Mode.
Velocity Gripper movement speed.
Force The gripper’s force.

Current Position

It is the area displaying the current position measured
through the gripper’s grasp/release motion tests.

Grasp

Performs tests for grasping a target item.

Release

Performs tests for releasing a target item.

Add New Motion

A new motion can be added. Up to eight motions can be
added.

Finger A Position

This is the input signal for the position of gripper finger A.

Finger B Position

This is the input signal for the position of gripper finger B.

Finger C Position

This is the input signal for the position of gripper finger C.

Scissor Position

This is the input signal for the position of the gripper
scissor.

Finger A Current

This is the signal for the present current value of gripper
finger A.

Finger B Current

This is the signal for the present current value of gripper
finger B.

Finger C Current

This is the signal for the present current value of gripper
finger C.

Scissor Current

This is the input signal for the current current value of the
gripper scissor.

Gripper Status

This is the input signal for the gripper’s status.

Item Status

This is the input signal for the item detected by the gripper.
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Defect Status This is the input signal code for the gripper defect status.

The following list contains skills and commands that can be used in conjunction with skills and
commands that can be used in conjunction with this Workcell item.

« Grasp

* Release

« Pick

* Place

« Pick Pallet

* Place Pallet

. Insert

5.2.11 Sick - Safety Laser Scanner

Only safety input signals can be selected, and the light

Protective Field curtain detection status is displayed.

Port Number This selects the port number for the safety input signal.

Configures the safety input mode for the input signal
Input Mode configuring the safety input signal. NC / NC, NC / NO and
NO / NO modes are available.

Motion It checks the status of the input signal.
Only safety input signals/controller ports can be selected,
Warning Field y . yinp .g . p_ .
and the light curtain detection status is displayed.
Error It displays the sensed error and checks its status by text.
Reset Required It displays whether reset is necessary.

5.2.12 Sick - Safety Light Curtain
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Port Number It selects the port number of the corresponding signal.

Motion It outputs an On or Off signal through the selected port.

It displays the input signal for whether detection is made by

Safety Light Curtai
atety Light Lurtain the light curtain.

Port Number It selects the port number of the corresponding signal.

Configures the safety input mode for the input signal
Input Mode configuring the safety input signal. NC / NC, NC / NO and
NO / NO modes are available.

Motion It checks the status of the input signal.

5.2.13 Omron - MC3

Port Number It selects the port number of the corresponding signal.
Motion It outputs a Reset signal through the selected port.
It displays the input signal for whether detection is made by
Safety Mat
the Safety Mat.
Port Number It selects the port number of the corresponding signal.

Configures the safety input mode for the input signal
Input Mode configuring the safety input signal. NC / NC, NC / NO and
NO / NO modes are available.

Motion It checks the status of the input signal.

5.2.14 Doosan - Lynx Series

It selects the predefined Modbus address. The IP address
and name configured by the user for the Modbus slave
equipment are displayed. To add new items, go to Setting
> Network > Predefined Modbus menu, and configure.

Modbus Address

Equipment is connected to the selected Modbus address,

Connect and buttons used to test gripper motion are activated.
Motion It sends the signal of the corresponding output.
Robot Online It sends the Robot Online status to MC. The interface
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signal operates normally only if this signal is on.

Robot in the inside of It goes on when the Robot Arm enters the equipment
machine interior.
Open M/C Door Front or Top Door opens automatically.
Close M/C Door Front or Top Door closes automatically.

When the corresponding signal is On, the MC starts the

Start program
prog NC-program.

When the corresponding signal is On, the MC unclamps

Open chuck#1(LH Spindle) the Chuck

When the corresponding signal is On, the MC clamps the

Close chuck#1(LH Spindle) Chuck

When the corresponding signal is On, the MC air blows the

| LH spindl
Clean spindle spindle.

When the corresponding signal is On, the MC finishes the

LH Chuck loaded
. load signal and executes the next block.

When the corresponding signal is On, the MC finishes the
LH Chuck unloaded Service M-code request signal and executes the next
block.

When the corresponding signal is On, the MC finishes the
Tailstock forward Service M-code request signal and executes the next
block.

When the corresponding signal is On, the MC finishes the
Tailstock backward Service M-code request signal and executes the next
block.

When Serve & MC Ready is set in MEM Mode, it outputs

Machine Online L
this signal through the Robot.

It is the signal allowing Robot arm approach, and the signal
is outputted under the following conditions:

- MC Home position

- Spindle stop

Prermission to Robot
- Robot uses
- MEM Mode

- No Machine lock

- Door open
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Cycle on

This signal is outputted when the NC-program is in auto
operation.

M/C Door opened

This signal is outputted when the Robot Approach Door is
opened.

M/C Door closed

This signal is outputted when the Robot Approach Door is
closed.

Program end

When processing is complete, M02 or M30 is executed and
then this signal is outputted. This signal is maintained until
NC is reset, auto mode changes to manual mode, or auto
operation begins.

Open chuck#1(LH Spindle)

It is the Main Chuck unclamp check signal.

Close chuck#1(LH Spindle)

It is the Main Chuck clamp check signal.

Clean LH spindle

It is the Spindle air blow completion signal.

Load LH Chuck

It is the Robot arm approach request signal for new
workpiece approach. The signal must be outputted under
the following conditions:

- MC Home position
- Spindle stop

- Robot uses

- MEM Mode

- No Machine lock

- Door open

- No Robot alarm

Unload LH Chuck

It is the Robot arm approach request signal for new
workpiece discharge. The signal must be outputted under
the following conditions:

- MC Home position

- Spindle stop

- Robot uses

- MEM Mode

- No Machine lock

- Door open

- No Robot alarm

Tailstock forward

It is the Tailstock forward/backward completion signal.

Tailstock backward

It is the Tailstock forward/backward completion signal.

The following list contains skills and commands that can be used in conjunction with skills and
commands that can be used in conjunction with this Workcell item.
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Open TC Door
Close TC Door
Open TC Chuck
Close TC Chuck
Start TC

Check TC Ready
Robot Online
Workpiece Clean
Tailstock Forward
Tailstock Backward
Pick TC Chuck
Place TC Chuck

Doosan Robotics Reference Manual v1.4
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5.2.15 Doosan - Puma Series

Modbus Address

It selects the predefined Modbus address. The IP address
and name configured by the user for the Modbus slave
equipment are displayed. To add new items, go to Setting
> Network > Predefined Modbus menu, and configure.

Equipment is connected to the selected Modbus address,

Connect and buttons used to test gripper motion are activated.
Motion It sends the signal of the corresponding output.
) It sends the Robot Online status to MC. The interface
Robot Online

signal operates normally only if this signal is on.

Robot in the inside of
machine

It goes on when the Robot Arm enters the equipment
interior.

Open M/C Door

Front or Top Door opens automatically.

Close M/C Door

Front or Top Door closes automatically.

Start program

When the corresponding signal is On, the MC starts the
NC-program.

Open chuck#1(LH Spindle)

When the corresponding signal is On, the MC unclamps
the Chuck.

Close chuck#1(LH Spindle)

When the corresponding signal is On, the MC clamps the
Chuck.

Clean LH spindle

When the corresponding signal is On, the MC air blows the
Spindle.

LH Chuck loaded

When the corresponding signal is On, the MC finishes the
load signal and executes the next block.

LH Chuck unloaded

When the corresponding signal is On, the MC finishes the
Service M-code request signal and executes the next
block.

Tailstock forward

When the corresponding signal is On, the MC finishes the
Service M-code request signal and executes the next
block.

Tailstock backward

When the corresponding signal is On, the MC finishes the
Service M-code request signal and executes the next
block.

Machine Online

When Serve & MC Ready is set in MEM Mode, it outputs
this signal through the Robot.
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It is the signal allowing Robot arm approach, and the signal
is outputted under the following conditions:

- MC Home position

- Spindle stop

Prermission to Robot
- Robot uses

- MEM Mode

- No Machine lock

- Door open

This signal is outputted when the NC-program is in auto

Cycle on .
operation.

This signal is outputted when the Robot Approach Door is

M/C Door opened
opened.

This signal is outputted when the Robot Approach Door is

M/C Door closed
closed.

When processing is complete, M02 or M30 is executed and
then this signal is outputted. This signal is maintained until
NC is reset, auto mode changes to manual mode, or auto
operation begins.

Program end

Open chuck#1(LH Spindle) It is the Main Chuck unclamp check signal.

Close chuck#1(LH Spindle) It is the Main Chuck clamp check signal.

Clean LH spindle It is the Spindle air blow completion signal.

It is the Robot arm approach request signal for new
workpiece approach. The signal must be outputted under
the following conditions:

- MC Home position
- Spindle stop

Load LH Chuck - Robot uses

- MEM Mode

- No Machine lock
- Door open

- No Robot alarm
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Unload LH Chuck

It is the Robot arm approach request signal for new
workpiece discharge. The signal must be outputted under
the following conditions:

- MC Home position

- Spindle stop

- Robot uses

- MEM Mode

- No Machine lock

- Door open

- No Robot alarm

Tailstock forward

It is the Tailstock forward/backward completion signal.

Tailstock backward

It is the Tailstock forward/backward completion signal.

The following list contains skills and commands that can be used in conjunction with this Workcell item.

« Open TC Door

e Close TC Door

*  Open TC Chuck
« Close TC Chuck
o StartTC

» Check TC Ready
* Robot Online

*  Workpiece Clean
e  Tailstock Forward
»  Tailstock Backward
e Pick TC Chuck

. Place TC Chuck

5.2.16 OnRobot RG2

Modbus Address

It selects the predefined Modbus address. The IP address
and name configured by the user for the Modbus slave
equipment are displayed. To add new items, go to Setting
> Network > Predefined Modbus menu, and configure.

Connect

Equipment is connected to the selected Modbus address,
and buttons used to test gripper motion are activated.
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The gripper position when the corresponding workpiece is

Grasp grasped.

Release ;I'ehlzag']sr;?er position when the corresponding workpiece is
Force The gripper’s force.
Grasp Performs tests for grasping a target item.

Release Performs tests for releasing a target item.

A new motion can be added. Up to eight motions can be

Add N Moti
dd New Motion added.

It is the current gripper depth that will be used to
compensate for the gripper’s depth. The depth is based on
the completely closed position set in 1/10 mm increments.
The value is displayed in complements on two.

Actual depth

It is the current gripper depth that will be used to
compensate for the gripper’s depth. The depth is based on
the recent motion start position set in 1/10 mm increments.
The value is displayed in complements on two.

Actual relative depth

The current width between gripper fingers is displayed in

Actual width
1/10 mm increments.

Status It displays the current state and motion of the gripper.

The following list contains skills and commands that can be used in conjunction with this Workcell item.

e« Grasp

* Release

*  Pick

+ Place

+  Pick Pallet

. Place Pallet

. Insert

5.2.17 OnRobot RG6
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It selects the predefined Modbus address. The IP address
and name configured by the user for the Modbus slave
equipment are displayed. To add new items, go to Setting
> Network > Predefined Modbus menu, and configure.

Modbus Address

Equipment is connected to the selected Modbus address,

Connect and buttons used to test gripper motion are activated.
Gras The gripper position when the corresponding workpiece is
P grasped.
The gripper position when the corresponding workpiece is
Release gripper p p g p
released.
Force The gripper’s force.
Grasp Performs tests for grasping a target item.
Release Performs tests for releasing a target item.

A new motion can be added. Up to eight motions can be

Add N Moti
dd New Motion added.

It is the current gripper depth that will be used to
compensate for the gripper’s depth. The depth is based on
the completely closed position set in 1/10 mm increments.
The value is displayed in complements on two.

Actual depth

It is the current gripper depth that will be used to
compensate for the gripper’s depth. The depth is based on
the recent motion start position set in 1/10 mm increments.
The value is displayed in complements on two.

Actual relative depth

The current width between gripper fingers is displayed in

Actual width
1/10 mm increments.

Status It displays the current state and motion of the gripper.

The following list contains skills and commands that can be used in conjunction with this Workcell item.

e« Grasp

* Release

*  Pick

« Place

+  Pick Pallet

» Place Pallet

. Insert
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osan Robotics

Part 2
Task Programming
Commands and Templates
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1.
1.1

1.2

Skill Command

Skill Command Summary

This is a function programmed through the robot and peripherals, and to use skills, it is necessary to

configure the work and related Workcell items. Necessary Workcell items are indicated in each skill
description.

Understanding Basic Principles of Skill Commands

Skill commands are based on a few operation patterns.

For a robot to begin operation, the weight and tool center point (TCP) of the tool equipped on the robot

must be configured, and the basic operation pattern of a skill command is to have an approach pose
that is perpendicular to the action pose.

TCP Setting: Using an End Effector skill command will automatically change the TCP offset setting.
The End Effector skill command execution stage includes an offset setting suited for the TCP of the

End Effector. If the TCP offset changes, the Blending Motion function, which smoothly connects the
previous motion command, cannot be used.
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Move to Approach Pose: It is a point available to move to the Approach Pose. It is set in the -Z
direction from the Approach Pose, and a different direction can also be selected. The Approach
Distance entered is automatically calculated for the Action Pose and moves to the corresponding point.
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Move to Action pose: This is the point on the workpiece where the End Effector performs work. (i.e.,
Picking Pose, Placing Pose)

Action Pose

Move to Retract Pose: This is the point to pick up the workpiece and safely move to another point. It
is the -Z direction from the Approach Pose, and a different direction can also be selected. The Retract
Distance entered is automatically calculated for the Action Pose and moves to the corresponding point.
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Retract Pose

Move to Action Start Pose: If the End Effector execution target does not end with a single motion,

there may be an intermediate point and an end point, and the Action Start Pose is the point where the
work starts. (i.e. Door Open Skill - Start Pose, Screw Drive Skill — Start Pose)

End Pose

End Pose

Move to Action End Pose: If the End Effector execution target does not end with a single motion,

there may be an intermediate point and an end point, and the Action End Pose is the point where the
work ends. (i.e. Door Open Skill — End Pose, Screw Drive Skill - End Pose)
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1.3
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Compliance Control and Contact Check

With the Compliance Control and Contact Check functions, which is the unique force control

technology of Doosan Robotics, it is possible to easily perform teaching without repeated operation for

accurate point designation, as it allows position deviation within an allowance range between the
workpiece and surrounding items during robot operation.

Compliance Control: If force is applied during Approach, - Action = and Retract, it allows deviation
from the set position with some level of buffering, like a spring.

i A
Compliance

w2

o

Action Pose

Action Pose Action Pose

Contact Check: Based on the Contact Force, Contact Determination Range and Authorized
Force values entered, the function detects contact with the target, stops at a corresponding position
and activates the gripper to grab the target.

This function must be used with Compliance Control Function. If Force is entered and Compliance
Control is not enabled, an error occurs.

Contact is a function that detects contact with an external force, so the sensitivity of Collision
Detection must be set at low levels or Collision Detection must be disabled.
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»  Pick skills (Pallet, Line, Destacking) have Scratch Offset to prevent scratching of the bottom or
the object.

» Be careful when using this function, as excessive force can be generated when contacting the
external environment if the Compliance Control option stiffness (i.e., z-direction) value is too large
or the work speed is too high. (It is necessary to make adjustments according to the situation by
lowering the stiffness value if the work speed is too high or by increasing the stiffness if work speed
is too low.)

Retract Pose

Contact Check :
Contact Point
Approach Pose 2zt ontact Poin

Action Pose Action Pose Action Pose

I Note

If contact with a force greater than the set range occurs with Contact Check enabled, a notification
window is displayed. To remove the obstacle and continue work, press the Continue button on the
notification window and remove the obstacle.
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1.4 Common Setting Options of Skill Command

« Perform direct teaching to the robot or use the job to position the robot in grab pose/default
pose/action pose.

« Tap the Save Pose or Pallet button to load the current coordinates/movement speed of the robot).

« The Contact Force and margin (Contact Detection Range) for determining contact with external
force can be configured.

« If Stiffness Control is used, turn on the toggle switch for Compliance Control. With Stiffness
Control, it is possible to set the values (Stiffness) of each axis.

« If Contact Check is required, turn on the toggle switch for Contact Check. Then the Contact Force
and margin (Contact Detection Range) can be configured.

Direction It configures the direction of work. (Default: Z-direction)

This configures the offset distance for the Action Pose to

Approach Distance
allow safe access to the target.

This configures the offset distance for the Action Pose to

Retract Distance i . - .
allow moving without colliding with the target.

This configures the speed required to approach the Action

Approach Velocity Pose

This configures the speed required to retract from the

Retract Velocity Reference Pose

This configures the acceleration required to approach or

Approach/Retract retract from the Action Pose. Low (250 mm/s?), Mid (500
Acceleration mm/s?) and High (1000 mm/s?) are available. (Default:
High)

Compliance Control (On/Off) | Itis the switch that turns Compliance Control on/off.

Stiffness It configures the Stiffness required for Compliance Control.
Time (wait time) It is the wait time required after operation.
Contact Check (On/Off) It is the switch that turns  Contact Check on/off.
Contact Force It is the force required to determine a contact.
Contact Detection Range It is the margin required to determine a contact.

It is the level of force authorized in the working direction

Force L
when contact force detection is used.

Scratch Offset is the offset to prevent scratching of the

Scratch Offset
bottom or the object.
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When executing Pick/Place skills with Compliance Control
Tool Weight Setting applied, this designates the tool weight value for picking or
placing an item.

When setting the Teaching Pose, the user can select a
Coordinate Setting coordinate (Base, Tool, World)(all except Insert, Line,
Pallet, Pallet (Rhombus) and Pallet Stack are available)

It configures the point where the target pick-up pose is

Pick-up Pose resumed.

1.5 Skill Command List

151 Airblow

It is a command that configures the motions of cleaning the target or equipment using the airblow
nozzle. Entering a time value will execute cleaning of a single point for the time entered.

Item Description

The Workcell item required for configuring the

Airblow Nozzle corresponding skill can be tested or used in the instruction
process.

Operation Point This configures the Airblowing start pose.

152 Bolt Shooting

It is the command to feed bolts through the Screw Bolt Feeder.

15.3 Check

It is the command for checking whether work is complete.

On It is the button for starting work.

Off It is the button for ending work.

The following is a list of Check commands.

e Check TC Ready
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+  Check Press Machine Ready
«  Check Injection Molding Machine Ready

«  Screw OK/NG Check

154 Close TC Chuck

It is the command to close the Turning Center Chuck.

Item Description

Open Chuck It is the button for opening the chuck.

Close Chuck It is the button for closing the chuck.

155 Close TC Door

It is the command to close the Turning Center Door.

Item Description

Open door It is the button for opening the Turning Center Door.

Close door It is the button for closing the Turning Center Door.

1.5.6 Close TC Manual Door

It is a skill configured to execute the motion of closing the Turning Center Door. The Close TC
Manual Door skill consists of two motions: i) a motion using only point control, and ii) a motion using
point control and Compliance Control.

This configures the start pose of the motion for closing the

Motion Start Pose
door.

Motion End Pose This configures the end pose for closing the door.
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1.5.7 Deburr (Hole)

It is the skill that deburrs the interior of a hole using a deburring tool. It performs deburring according
to the hole depth and repeat count configured based on the point entered.

Item Description

The Workcell item required for configuring the

Deburring Tool corresponding skill can be tested or used in the instruction
process.

Operation Point This configures the deburring start pose.
Enter the depth of the hole. It calculates the end pose of

Hole Depth . .
the repeat motion considering the hole depth.
Area Repeat Count Enter the number of repeat motions to be performed.
158 Deburr (Hole) Line

It is the skill that deburrs the interior of a hole positioned in a linear pattern using a rotating deburring
tool. It performs work according to the hole depth and repeat count configured based on the position
set on a linear pattern.

Item Description

It displays the Workcell item required for configuring the
Linear Pattern corresponding skill. Click the button to change pattern
settings related to the skill.

The Workcell item required for configuring the

Deburring Tool corresponding skill can be tested or used in the instruction
process.
. It configures the speed at which the robot moves to a
Velocity

specific point on the pallet.

Select the counter which acts as the reference point for

position change on the pattern. Selecting a MainSub will
o change the position according to the increase in the all-

Position Change Count area counter of the task program.

Placing this skill between Repeat syntax will allow counters
of the corresponding Repeat syntax.

159 Deburr (Hole) Pallet
It is the skill that deburrs the interior of a hole positioned in a pallet pattern using a rotating deburring

tool. It performs work according to the hole depth and repeat count configured based on the position
set on a pallet pattern.
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Pallet

It displays the Workcell item required for configuring the
corresponding skill. Click the button to change pattern
settings related to the skill.

Deburring Tool

The Workcell item required for configuring the
corresponding skill can be tested or used in the instruction
process.

Velocity

It configures the speed at which the robot moves to a
specific point on the pallet.

Position Change Count

Select the counter which acts as the reference point for

position change on the pattern. Selecting a MainSub will
change the position according to the increase in the all-

area counter of the task program.

Placing this skill between Repeat syntax will allow counters
of the corresponding Repeat syntax.

I Note

Pallet-related skills are matched to the pattern position corresponding to the configuring pattern. If a
variety of pallets are used, related skills can be differentiated using the pallet’s name.

1.5.10 Destacking

It is a skill that handles objects with identical shapes stacked in a pattern by automatically calculating
their locations according to the number of stacks entered. The Destacking skill consists of three
motions: i) a motion using only point control, ii) a motion using point control and Compliance Control,
and iii) a motion using point control, Compliance Control and Contact Check.

Item Description

Gripper

The Workcell item required for configuring the
corresponding skill can be tested or used in the instruction
process.

Reference Pose

This configures the Reference Pose of the work.

Thickness

This configures the thickness of the workpiece.

Count

This configures the number of workpiece.
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1511 Destacking Line

It is a skill that handles objects with identical shapes stacked in a linear pattern by automatically
calculating their locations according to the number of stacks entered.

Item Description

It displays the Workcell item required for configuring the
Line Pattern corresponding skill. Click the button to change pattern
settings related to the skill.

The Workcell item required for configuring the
Gripper corresponding skill can be tested or used in the instruction
process.

It configures the speed at which the robot moves to a

Velocity specific point on the pallet.

Select the counter that acts as the reference point for
position change on the pattern. Selecting a MainSub will
o change the position according to the increase in the all-
Position Change Count area counter of the task program.

Placing this skill between Repeat syntax will allow counters
of the corresponding Repeat syntax.

1.5.12 Destacking Pallet

It is a skill that handles objects stacked on a pallet with identical shapes by automatically calculating
their locations according to the number of stacks entered.

Iltem Description

It displays the Workcell item required for configuring the
Pallet corresponding skill. Click the button to change pallet
settings related to the skill.

The Workcell item required for configuring the
Gripper corresponding skill can be tested or used in the instruction
process.

It configures the speed at which the robot moves to a

Velocity specific point on the pallet.

Select the counter which acts as the reference point for
position change on the pattern. Selecting a MainSub will
change the position according to the increase in the all-
Position Change Count area counter of the task program.

Placing this skill between Repeat syntax will allow counters
of the corresponding Repeat syntax.

I Note

Pallet-related skills are matched to the pattern position corresponding to the configuring pattern. If a
variety of pallets are used, related skills can be differentiated using the pallet's name.
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1.5.13 End

It is the skill that defines the end pose of the corresponding tool in a continuous deburring routine on a
target. When the previous motions are complete, it stops operation and retreats to the configured
direction based on the end point of the previous motion.

The Workcell item required for configuring the
Tool corresponding skill can be tested or used in the instruction
process.

The following is a list of End Skills according to the tool:
End Glue
End Deburr
End Polish

It can be operated with default settings without additional configurations.

1.5.14 Glue (Point)

It is the skill that discharges glue on the instructed point. Entering a time value will execute gluing at a
single point for the time entered.

Item Description

The Workcell item required for configuring the
Gluing Tool corresponding skill can be tested or used in the instruction
process.
Operation Point This configures the gluing start pose.

1.5.15 Glue (Point) Line

It is the skill that discharges gluein a linear pattern. Entering a time value will execute gluing at a
single point in a linear pattern for the time entered.

Item Description

It displays the Workcell item required for configuring the
Linear Pattern corresponding skill. Click the button to change pattern
settings related to the skill.

The Workcell item required for configuring the
Gluing Tool corresponding skill can be tested or used in the instruction
process.

Select the counter which acts as the reference point for

Position Change Count . i . )
position change on the pattern. Selecting a MainSub will
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change the position according to the increase in the all-
area counter of the task program.

Placing this skill between Repeat syntax will allow counters
of the corresponding Repeat syntax.

1.5.16 Glue (Point) Pallet

It is the skill that discharges gluein a pallet pattern. Entering a time value will execute gluing at a
single point in a pallet pattern for the time entered.

It displays the Workcell item required for configuring the
Pallet corresponding skill. Click the button to change pattern
settings related to the skill.

The Workcell item required for configuring the
Gluing Tool corresponding skill can be tested or used in the instruction
process.

Select the counter which acts as the reference point for

position change on the pattern. Selecting a MainSub will
o change the position according to the increase in the all-

Position Change Count area counter of the task program.

Placing this skill between Repeat syntax will allow counters
of the corresponding Repeat syntax.

I Note

Pallet-related skills are matched to the pattern position corresponding to the configuring pattern. If a
variety of pallets are used, related skills can be differentiated using the pallet’'s name.

1.5.17 Grasp

It is the command to close the gripper.

Item Description

Grasp It is the button for closing the gripper.

Release It is the button for opening the gripper.

1.5.18 Insert

It is a skill that finds the target point by searching with Spiral motion near the target point when the
workpiece must be inserted into a hole at an inaccurate point. If the workpiece must be inserted into
the target in tasks, such as gear assembly, it is possible to execute insertion motions by inserting
incorrectly positioned workpieces through periodic motions. Insert skill requires contact with external
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forces, so it requires Compliance Control by default.

«  Spiral Search motion and Rotation Search motion to find holes must be configured.

«  For Spiral Search motion, Max. Revolutions, Max. Radius, Velocity and Acceleration can be

configured.

« For Rotation Search motion, Amplitude, Period and Repeat can be configured.

» The user can configure Timeout as a method to notify the failures of the two motions.

Item Description

Pneumatic Gripper

Displays the Workcell item (Insert > Pneumatic Gripper)
required for configuring the corresponding skill.

Reference Pose

This configures the point point where the workpiece is
inserted in the hole.

Depth

It configures the depth of the hole.

Force

This configures the force applied in the movement
direction.

Spiral Interval

Configures the spiral interval of Spiral motion.

Max. Revolutions

This configures the total revolution count of the Spiral
motion.

Max. Radius

This configures the final radius of the Spiral motion.

Velocity

This configures the velocity of the Spiral motion.

Acceleration

This configures the acceleration of the Spiral motion.

Amplitude This configures the amplitude of the periodic motion.
Period This configures the period of the periodic motion.
Repeat This configures the repetition count of the periodic motion.
Timeout This configures the time required for checking failed work.

1.5.19 Machine Reset

It is the command to reset the machine tool.

Description

On

It is the button for starting the Turning Center work.
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Off It is the button for ending the Turning Center Work.

1.5.20 Open TC Chuck

It is the command to open the Turning Center Chuck.

Open Chuck It is the button for opening the chuck.

Close Chuck It is the button for closing the chuck.

1.5.21 Open TC Door

It is the command to open the Turning Center Door.

Item Description
Open door It is the button for opening the Turning Center Door.
Close door It is the button for closing the Turning Center Door.

1.5.22 Open TC Manual Door

It is a skill configured to execute the motion of opening the Turning Center Door. The Open TC
Manual Door skill consists of two motions: i) a motion using only point control, and ii) a motion using
point control and Compliance Control.

Item Description

It configures the Start Pose of the motion for opening the

Motion Start Pose
door.

Motion End Pose It configures the End Pose for closing the door.

1.5.23 Pick

This skill operates the gripper and picks up the target when the robot moves to a specific point or
approaches and contacts a target. The Pick skill consists of three motions: i) a motion using only point
control, ii) a motion using point control and Compliance Control, and iii) a motion using point control,
Compliance Control and Contact Check.

Iltem

Description

The Workcell item required for configuring the
corresponding skill can be tested or used in the instruction

Gripper




process.

Open Gripper before
Approaching

If there is a situation where the gripper is closed before
moving to the point to pick up the target, this option can be
used to prevent collision with the target.

I Note

If the speed and relative coordinate settings for each motion of Pick are required, click the >
button on the right side of Pick-up Pose.

1.5.24 Pick Injection Molding Machine

This skill operates the gripper and picks up the target from a discharge unit of an injection molding
machine when the robot moves to a specific point or approaches and contacts a target at an instructed
point. It consists of three motions: i) a motion using only point control, ii) a motion using point control
and Compliance Control, and iii) a motion using point control, Compliance Control and Contact Check.

Gripper

The Workcell item required for configuring the
corresponding skill can be tested or used in the instruction
process.

Injection Molding Machine

The Workcell item required for configuring the
corresponding skill can be tested or used in the instruction
process.
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1.5.25 Pick Line

This skill operates the gripper and picks up the target when the robot moves to a specific point or
approaches and contacts a target on a linear pattern. The motion point is entered when defining the
Workcell item pallet, and the entered point is automatically utilized when the skill is used. The Pick
Line skill consists of three motions: i) a motion using only point control, ii) a motion using point control
and Compliance Control, and iii) a motion using point control, Compliance Control and Contact Check.

Linear Pattern

It displays the Workcell item required for configuring the
corresponding skill. Click the button to change pattern
settings related to the skill.

The Workcell item required for configuring the

Gripper corresponding skill can be tested or used in the instruction
process.
. It configures the speed at which the robot moves to a
Velocity

specific point on the pallet.

Position Change Count

Select the counter which acts as the reference point for

position change on the pattern. Selecting a MainSub will
change the position according to the increase in the all-

area counter of the task program.

Placing this skill between Repeat syntax will allow counters
of the corresponding Repeat syntax.

1.5.26 Pick Pallet

This skill operates the gripper and picks up the target when the robot moves to a specific point on the
pallet or approaches and contacts a target. The motion point is entered when defining the Workcell
item pallet, and the entered point is automatically utilized when the skill is used. The Pick Pallet skill
consists of three motions: i) a motion using only point control, ii) a motion using point control and
Compliance Control, and iii) a motion using point control, Compliance Control and Contact Check.

Item Description

It displays the Workcell item (Pick Pallet > Pallet) required

Pallet Co . .
for configuring the corresponding skill.
The Workcell item required for configuring the
Gripper corresponding skill can be tested or used in the instruction
process.
. It configures the speed at which the robot moves to a
Velocity

specific point on the pallet.
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Select the counter which acts as the reference point for
position change on the pattern. Selecting a MainSub will
change the position according to the increase in the all-

Position Change Count area counter of the task program.

Placing this skill between Repeat syntax will allow counters
of the corresponding Repeat syntax.

I Note

Pallet-related skills are matched to the pattern position corresponding to the configuring pattern. If a
variety of pallets are used, related skills can be differentiated using the pallet’'s name.

1.5.27 Pick Press Machine

This skill operates the gripper and picks up the target from a press machine when the robot moves to
a specific point or approaches and contacts a target at an instructed point. It consists of three motions:
i) @ motion using only point control, ii) a motion using point control and Compliance Control, and iii) a
motion using point control, Compliance Control and Contact Check.

The Workcell item required for configuring the
Gripper corresponding skill can be tested or used in the instruction
process.

The Workcell item required for configuring the
Press Machine corresponding skill can be tested or used in the instruction
process.

1.5.28 Pick TC Chuck

This skill operates the gripper and picks up the target when the robot moves to a point instructed in
the Turning Center Chuck or approaches and contacts a target held by the chuck. Once the motion
point is instructed to the corresponding skill, it automatically instructs the point on the Place TC Chuck
for the same machine tool present on the canvas. The Pick TC Chuck skill consists of three motions: i)
a motion using only point control, ii) a motion using point control and Compliance Control, and iii) a
motion using point control, Compliance Control and Contact Check.

Item Description

The Workcell item required for configuring the
Gripper corresponding skill can be tested or used in the instruction
process.

It displays the Workcell item (Pick TC Chuck - Chuck )

Turning Cent
urning Lenter required for configuring the corresponding skill.
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1.5.29 Place

This skill operates the gripper and releases the target when the robot moves to a specific point or
approaches and contacts the work table. The Place skill consists of three motions: i) a motion using
only point control, ii) a motion using point control and Compliance Control, and iii) a motion using point
control, Compliance Control and Contact Check.

The Workcell item required for configuring the

Gripper corresponding skill can be tested or used in the instruction
process.
It configures the point where the target release pose is
Release 9 P 9 P

resumed.

1.5.30 Place Line

This skill operates the gripper and releases the target when the robot moves to a specific point on a
linear pattern or approaches and contacts the work table. The Place Line skill consists of three
motions: i) a motion using only point control, ii) a motion using point control and Compliance Control,
and iii) a motion using point control, Compliance Control and Contact Check.

Item Description

It displays the Workcell item required for configuring the
Line Pattern corresponding skill. Click the button to change pattern
settings related to the skill.

The Workcell item required for configuring the
Gripper corresponding skill can be tested or used in the instruction
process.

It configures the speed at which the robot moves to a

Velocity specific point on the pallet.

Select the counter which acts as the reference point for
position change on the pattern. Selecting a MainSub will
change the position according to the increase in the all-

Position Change Count area counter of the task program.

Placing this skill between Repeat syntax will allow counters
of the corresponding Repeat syntax.
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1.5.31 Place Pallet

This skill operates the gripper and releases the target when the robot moves to a specific point on the
pallet or approaches and contacts a target settlement point on the pallet. The motion point is entered
when defining the Workcell item pallet, and the entered point is automatically utilized when the skill is
used. The Place Pallet skill consists of three motions: i) a motion using only point control, ii) a motion
using point control and Compliance Control, and iii) a motion using point control, Compliance Control
and Contact Check.

It displays the Workcell item (Place Pallet > Pallet)

Pallet ) o . .
required for configuring the corresponding skill.
The Workcell item required for configuring the
Gripper corresponding skill can be tested or used in the instruction
process.
. It configures the speed at which the robot moves to a
Velocity

specific point on the pallet.

Select the counter which acts as the reference point for
position change on the pattern. Selecting a MainSub will
change the position according to the increase in the all-
Position Change Count area counter of the task program.

Placing this skill between Repeat syntax will allow counters
of the corresponding Repeat syntax.

I Note

Pallet-related skills are matched to the pattern position corresponding to the configuring pattern. If a
variety of pallets are used, related skills can be differentiated using the pallet’'s name.

1.5.32 Place Press Machine

This skill operates the gripper and releases the target when the robot moves to a point instructed on
the Turning Center Chuck or approaches and contacts the chuck. When the motion point is instructed
to the corresponding skill, it automatically instructs the point on the Pick Press Machine for the same
machine tool present on the canvas. The Place Press Machine skill consists of three motions: i) a
motion using only point control, ii) a motion using point control and Compliance Control, and iii) a
motion using point control, Compliance Control and Contact Check.

The Workcell item required for configuring the
Gripper corresponding skill can be tested or used in the instruction
process.

The Workcell item required for configuring the

Press Machine corresponding skill can be tested or used in the instruction
process.
Release Pose It configures the point where the target release pose is
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resumed.

1.5.33 Place TC Chuck

This skill operates the gripper and releases the target when the robot moves to a point instructed on
the Turning Center Chuck or approaches and contacts the chuck. Once the motion point is instructed
to the corresponding skill, it automatically instructs the point on the Pick TC Chuck for the same
machine tool present on the canvas. The Place TC Chuck skill consists of three motions: i) a motion
using only point control, ii) a motion using point control and Compliance Control, and iii) a motion using
point control, Compliance Control and Contact Check.

Item Description

The Workcell item required for configuring the
Gripper corresponding skill can be tested or used in the instruction
process.

It displays the Workcell item (Place TC Chuck - Chuck)

Turning Cent
urning tenter required for configuring the corresponding skill.

It configures the point where the target release pose is

Release Pose resumed.

1.5.34 Polish (Hole)

It is the skill that polishes the interior of a hole using a polishing tool. It performs deburring according to
the hole depth and repeat count configured based on the point entered.

Item Description

The Workcell item required for configuring the

Polishing Tool corresponding skill can be tested or used in the instruction
process.
Operation Point This configures the polishing start pose.
Enter the depth of the hole. It calculates the end pose of
Hole Depth . S
the repeat motion considering the hole depth.
Repeat Count Enter the number of repeat motions to be performed.

1.5.35 Polish (Hole) Line

It is the skill that polishes the interior of a hole positioned in a linear pattern using a rotating polishing
tool. It performs work according to the hole depth and repeat count configured based on the position
set on a linear pattern.



Linear Pattern

It displays the Workcell item required for configuring the
corresponding skill. Click the button to change pattern
settings related to the skill.

The Workcell item required for configuring the

Polishing Tool corresponding skill can be tested or used in the instruction
process.
. It configures the speed at which the robot moves to a
Velocity

specific point on the pallet.

Position Change Count

Select the counter which acts as the reference point for

position change on the pattern. Selecting a MainSub will
change the position according to the increase in the all-

area counter of the task program.

Placing this skill between Repeat syntax will allow counters
of the corresponding Repeat syntax.

1.5.36 Polish (Hole) Pallet

It is the skill that polishes the interior of a hole positioned in a pallet pattern using a rotating polishing
tool. It performs work according to the hole depth and repeat count configured based on the position

set on a pallet pattern.

It displays the Workcell item required for configuring the

Pallet corresponding skill. Click the button to change pattern
settings related to the skill.
The Workcell item required for configuring the
Polishing Tool corresponding skill can be tested or used in the instruction
process.
. It configures the speed at which the robot moves to a
Velocity

specific point on the pallet.

Position Change Count

Select the counter which acts as the reference point for

position change on the pattern. Selecting a MainSub will
change the position according to the increase in the all-

area counter of the task program.

Placing this skill between Repeat syntax will allow counters
of the corresponding Repeat syntax.

I Note

Pallet-related skills are matched to the pattern position corresponding to the configuring pattern. If a
variety of pallets are used, related skills can be differentiated using the pallet’'s name.

Doosan Robotics Reference Manual v1.4

62



1.5.37 Push

It is a skill that applies constant force in the direction the user configured to move the robot. Push skill
is a skill that requires force control in a specific direction, so it requires the Compliance Control by

default.
Reference Pose This configures the reference point force control initiates.

This configures the maximum distance moved towards the

Axis Distance direction of the force.

This configures the force applied in the movement

Force direction.

1.5.38 Release

It is the command to open the gripper.

Grasp It is the button for closing the gripper.

Release It is the button for opening the gripper.

1.5.39 Robot Online

It is the command for checking the connection between the robot and machine tool.

Item Description

On It is the button for starting the Turning Center work.

Off It is the button for ending the Turning Center Work.

1.5.40 Run

It is the command that executes the SkKill.

Item Description

On It is the button for turning on the Skill.

Off It is the button for turning off the Skill.

The following is a list of Run Skills:
* Run Screw

*  Run Airblow



« Run Glue
*  Run Deburr

. Run Polish

1541 Screw Pick Ready Check

It is the command to check whether the screw is ready in the Screw Bolt Feeder and to wait until a bolt
is fed to the Screwdriver.

1.5.42 Screwdrive

It moves the screwdriver to the target work point and moves it by the distance the user entered. It is a
skill that retracts the screwdriver to the Retract pose after the screwdriver completes its task,
recognized by receiving a completion signal or by reaching the distance entered. The Screwdrive skill
consists of three motions: i) a motion using only point control, ii) a motion using point control and
Compliance Control, and iii) a motion using point control, Compliance Control and Contact Check.

The Workcell item required for configuring the

Screwdriver corresponding skill can be tested or used in the instruction
process.
Operation Point This configures the screwing start pose.
Distance It is the distance moved to complete screwing.

If counter-rotation mode is set up in the Screwdriver
Counter-Rotation Mode workcell item, this mode setup allows you to configure
whether to use counter-rotation.

1.5.43 Screwdrive Line

It is a skill that screws bolts at designated locations based on a number entered in a linear pattern
calculated automatically.

It moves the screwdriver to the target work point and moves it by the distance the user entered. It is a
skill that retracts the screwdriver to the Retract pose after the screwdriver completes its task,
recognized by receiving a completion signal or by reaching the distance entered. The screwdrive skill
motion supports motion using point control, and motion control using point control and compliance

control.

It displays the Workcell item required for configuring the
Line Pattern corresponding skill. Click the button to change pattern
settings related to the skill.
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The Workcell item required for configuring the
Screwdriver corresponding skill can be tested or used in the instruction
process.

Configures the screwing point. Values must be saved

Operation Point . .
P based on the location where screwing was completed.

The distance until screwing is completed. It moves at the
Bolt Length speed entered from the point to the bolt length point based
on the motion point.

Select the counter which acts as the reference point for

position change on the pattern. Selecting a MainSub will
o change the position according to the increase in the all-

Position Change Count area counter of the task program.

Placing this skill between Repeat syntax will allow counters
of the corresponding Repeat syntax.

1.5.44 Stacking

It is a skill for stacking objects to a specific number the user entered by automatically calculating their
thickness. The Stacking skill consists of three motions: i) a motion using only point control, ii) a motion
using point control and Compliance Control, and iii) a motion using point control, Compliance Control

and Contact Check.

Item Description

The Workcell item required for configuring the
Gripper corresponding skill can be tested or used in the instruction
process.
Reference Pose This configures the Reference Pose of the work.
Thickness This configures the thickness of the workpiece.
Count This configures the number of workpieces.

1.5.45 Stacking Line

It is a skill to stack a specific number of objects the user entered on a linear pattern in a designated
location by automatically calculating their thickness. The Stacking Line skill consists of three motions: i)
a motion using only point control, ii) a motion using point control and Compliance Control, and iii) a
motion using point control, Compliance Control and Contact Check.

It displays the Workcell item required for configuring the
corresponding skill. Click the button to change pattern

Line Pattern
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settings related to the skill.

The Workcell item required for configuring the
Gripper corresponding skill can be tested or used in the instruction
process.

It configures the speed at which the robot moves to a

Velocity specific point on the pallet.

Select the counter which acts as the reference point for

position change on the pattern. Selecting a MainSub will
o change the position according to the increase in the all-

Position Change Count area counter of the task program.

Placing this skill between Repeat syntax will allow counters
of the corresponding Repeat syntax.

1.5.46 Stacking Pallet

It is a skill to stack a specific number of objects the user entered on a pallet in a designated location by
automatically calculating their thickness. The Stacking Pallet skill consists of three motions: i) a motion
using only point control, ii) a motion using point control and Compliance Control, and iii) a motion using
point control, Compliance Control and Contact Check.

Item Description

It displays the Workcell item required for configuring the
Pallet corresponding skill. Click the button to change pallet
settings related to the skill.

The Workcell item required for configuring the

Gripper corresponding skill can be tested or used in the instruction
process.
. It configures the speed at which the robot moves to a
Velocity

specific point on the pallet.

Select the counter which acts as the reference point for

position change on the pattern. Selecting a MainSub will
change the position according to the increase in the all-

Position Change Count area counter of the task program.

Placing this skill between Repeat syntax will allow counters
of the corresponding Repeat syntax.

I Note

Pallet-related skills are matched to the pattern position corresponding to the configuring pattern. If a
variety of pallets are used, related skills can be differentiated using the pallet’'s name.
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1.5.47 Start Deburr

It is the skill that defines the start pose of the Deburring Tool in a continuous deburring routine on a
target. Instructing the starting point for deburring on a continuous routine will move the tool up to the
point and execute the next motion after waiting for the configured wait time.

The Workcell item required for configuring the
Deburring Tool corresponding skill can be tested or used in the instruction
process.
Operation Point This configures the continuous deburring start pose.
Direction It configures the direction of work. (Default: Z-direction)
I Note

Start / End skills are always used in conjunction with each other. Freely teach the routine using
motion commands that can be used between Start and End. It is recommended to use Move Spline
command.

1.5.48 Start Glue

It is the skill that defines the start pose of the Gluing Tool in a continuous gluing routine on a target.
Instructing the starting point for gluing on a continuous routine will move the tool up to the point and
execute the next motion after waiting for the configured wait time.

Item Description

The Workcell item required for configuring the
Gluing Tool corresponding skill can be tested or used in the instruction
process.
Operation Point This configures the continuous gluing start pose.
Time It is the wait time required after operating the gluing tool.
I Note

Start / End skills are always used in conjunction. Start/End skill can start a task in the direction of
Tool Coordinates and Base Coordinates. Freely teach the routine using motion commands that can
be used between Start and End. It is recommended to use Move Spline command.

1.5.49 Start Injection Molding Machine

It is the command to start the Injection Molding Machine operation.
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It is the button for starting the Injection Molding Machine

(0]
: work.

It is the button for ending the Injection Molding Machine

Off
work.

1.5.50 Start Polish

It is the skill that defines the start pose of the Polishing Tool in a continuous polishing routine on a
target. Instructing the starting point for polishing on a continuous routine will move the tool up to the
point and execute the next motion after waiting for the configured wait time.

The Workcell item required for configuring the
Polishing Tool corresponding skill can be tested or used in the instruction
process.
Motion Start Pose This configures the continuous polishing start pose.
Force This configures the force applied in the operation direction.
I Note

Start / End skills are always used in conjunction. Freely teach the routine using motion
commands that can be used between Start and End. It is recommended to use Move Spline
command.

The compliance function must simultaneously be enabled or disabled on Start/End skill.

1.5.51 Start Press Machine

It is the command to start Press Machine operation.

Item Description

On It is the button for starting Press Machine work.

Off It is the button for ending the Press Machine work.

1.5.52 Start TC

It is the command to start Turning Center operation.
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On It is the button for starting the Turning Center work.

Off It is the button for ending the Turning Center work.

1.5.53 Steady Rest Clamp

It is the command to close the machine tool steady rest.

Item Description

Close Steady Rest It is the button for closing the machine tool, Steady Rest.

Open Steady Rest It is the button for opening the machine tool, Steady Rest.

1.5.54 Steady Rest Unclamp

It is the command to open the machine tool steady rest.

Item Description

Close Steady Rest It is the button for closing the machine tool, Steady Rest.
Open Steady Rest It is the button for opening the machine tool, Steady Rest.
1.5.55 Stop

It is the command for stopping Skill operation.

On It is the button for turning on the Skill.

Off It is the button for turning off the Skill.

The following is a list of Stop commands.
«  Stop Airblow

e  Stop Deburr

»  Stop Glue

»  Stop Polish

e Stop Screw



1.5.56 Tailstock Forward

It is the command to move the machine tool tailstock forward.

Item Description

It is the button for moving the machine tool Tailstock

Tailstock Forward
forward.

Tailstock Retreat It is the button for retracting the machine tool Tailstock.

1.5.57 Tailstock Backward

It is the command to move the machine tool Tailstock backward.

Item Description

It is the button for moving the machine tool Tailstock

Tailstock Forward
forward.

Tailstock Retreat It is the button for retracting the machine tool Tailstock.

1.5.58 Touch

It is the skill that stops movement to the target position when external force is detectedand retracts to
the Retreat Pose. Touch skill is a skill that stops operation when external force is detected, so it
requires Compliance Control by default.

Description

Reference Pose This configures the target contact detection point.

1.5.59 Workpiece Clean

It is the command to operate the airblow device installed on the machine tool to clean the workpiece.

On It is the button for starting workpiece cleaning.

Off It is the button for ending workpiece cleaning.
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2. Task Template

Task Template is a bundle of Skills that compose a work procedure used with a combination of
Workcell items when a particular Workcell item is registered. It is possible to easily create a task with
the settings of Skills already in the template without worrying about the work process.

2.1 Part Handling

It is the template for handling the target. It is fundamentally composed of Pick and Place skills. A
template is recommended depending on whether a single gripper or two grippers are installed on the
robot flange. Related Workcell items are as follows:

*  Pneumatic Gripper

211 Single Gripper

Work Procedure Command
Grasp_ the Pick
workpiece

Releas_e the Place
workpiece

2.1.2 Double Gripper

Work Procedure Command
Grasp workpiece #1 Pick
Grasp workpiece #2 Pick

Release workpiece #1 Place

Release workpiece #2 Place




2.2

CNC Machine Tending

It is the template for secondary work of the machine tool. The machine tool template recommends a
template depending on whether a single gripper or two grippers are installed on the robot flange.

Related Workcell items are as follows:

*  Pneumatic Gripper

e Turning Center

« Airblow Nozzle

« Pallet
221 Single Gripper
Type 1 Type 2 Type 3 Type 4
Work Procedure i i i il
Command
Grasp the Pick Pallet Pick Pallet Pick Pallet Pick Pallet
workpiece
Chuck airblowing - - Airblow Airblow
Load _the Place TC Place TC Place TC Place TC
workpiece
Close door Close TC Door Close Manual TC Close TC Door Close Manual TC
Door Door
Start processing Start TC Start TC Start TC Start TC

TC ready check

Check TC Ready

Check TC Ready

Check TC Ready

Check TC Ready

Open door

Open TC Door

Open Manual TC

Open TC Door

Open Manual TC

2.2.2

Door Door

les-hed I?lece - - Airblow Airblow
Airblowing
Unload finished p Pick TC Pick TC Pick TC Pick TC
Releaps)i(?a(f:lglshed Place Pallet Place Pallet Place Pallet Place Pallet
Double Gripper
Type 1 Type 2 Type 3 Type 4
Work Procedure i - P P

Command
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Grasp the
workpiece

Pick Pallet

Pick Pallet

Pick Pallet

Pick Pallet

TC ready check

Check TC Ready

Check TC Ready

Check TC Ready

Check TC Ready

Open Auto TC

Open Manual TC

Open Auto TC

Open Manual TC

Open door Door Door Door Door
F|n|§hed piece - - Airblow Airblow
airblowing
Unload finished Pick TC Pick TC Pick TC Pick TC
piece
Chuck airblowing - - Airblow Airblow
Load _the Place TC Place TC Place TC Place TC
workpiece
Close Auto TC Close Manual TC Close Auto TC Close Manual TC
Close door
Door Door Door Door
Start processing Start TC Start TC Start TC Start TC
Release finished Place Pallet Place Pallet Place Pallet Place Pallet

piece
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2.3 Press Machine Tending

It is the template for secondary work of the machine tool. The machine tool template recommends a
template depending on whether a single gripper or two grippers are installed on the robot flange.
Related Workcell items are as follows:

«  Vacuum Gripper

. Press Machine

2.3.1 Single Gripper

Work Procedure Command
Grasp the workpiece Pick
Load the workpiece Place Press Machine
Start processing Start Press Machine

Press Machine Ready Check  Check Press Machine Ready

Unload finished piece Pick Press Machine

Release finished piece Place

2.3.2 Double Gripper

Work Procedure Command

Grasp the workpiece Pick

Press Machine Ready Check  Check Press Machine Ready

Unload finished piece Pick Press Machine

Load the workpiece Place Press Machine

Start processing Start Press Machine
Release finished piece Place
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2.4 Injection Molding Machine Tending

It is the template for secondary work of the machine tool. The machine tool template recommends a
template depending on whether a single gripper or two grippers are installed on the robot flange.
Related Workcell items are as follows:

«  Vacuum Gripper

« Injection Molding Machine

Work Procedure Command

Press Machine Ready Check Check Press Machine Ready

Unload finished piece Pick Press Machine
Start processing Start Press Machine
2.5 Screw Drive

It is the template for screw assembly work. A template is recommended depending on the Pick-up bolt
Feeder or Shooting bolt Feeder Workcell item settings. Related Workcell items are as follows:

»  Screwdriver
«  Shooting Bolt Feeder

»  Pickup Bolt Feeder

Type 1 Type 2
Work Procedure
Command
Feeder ready Check Feeder Ready N/A
check
Feed bolt Pick-up bolt Feeder Shoot Bolt
Grasp v;grkplece Screw Drive Screw Drive

75



2.6 Gluing

It is the template for continuous routine gluing work. Related Workcell items are as follows:

e Gluing Tool

Work Procedure Command

Start Gluing Start Glue

End Gluing End Glue

2.7 Deburring

It is the template for continuous routine deburring work. Related Workcell items are as follows:

«  Deburring Tool

Work Procedure  Command

Start Deburring ~ Start Deburr

End Deburring  End Deburr

2.8 Polishing

It is the template for continuous routine deburring work. Related Workcell items are as follows:

«  Polishing Tool

Work Procedure Command
Start Polishing Start Polish
End Polishing End Polish

Doosan Robotics Reference Manual v1.4 76



Part 3
Smart Vision Module



1.

Precautions before Use

The camera lens must be as parallel to the work surface as possible. The camera’s line of view
must be as perpendicular to the work surface as possible.

Reflections from work items and the surrounding environment within the camera’s measurement
area must be avoided.

The camera must measure the top view of the target item. If the item is slanted during
measurement, distortion and incorrect measurement may occur due to perspective views.

All cameras are heavily influenced by the illumination of the surroundings. Establish and maintain
a work condition of 300 lux or higher illumination in the camera measurement area.

For detailed information about measurable distance, field of view, and measurable item size and
height, please refer to corresponding sections describing product specifications.

When replacing SVM, create a job after deleting the vision command of the task including
the vision job command stored in TB (Task Builder) or TW (Task Writer) on the TP (Teaching
Pendant). You can delete a vision command after deleting commands that depends on the

Vision Command.



2. Setting with Workcell Manager

Add the Smart Vision Module to the Workcell Manager and configure the Smart Vision Module
referring to the following setting options.

2.1 Camera Connection
< Ready v

= ) Confirm
==

Camera Connection

Peripheral

P 192 168 137 S

-—

2P

‘E'
&

Camera Test

The camera IP address is a static IP, and the default address
Connect (192.168.137.5) is used for connection.

After connection is successful, the Connect button is disabled.

Check the image in the camera's viewfinder to see if the camera is
working properly.

Live — Shoot Live: Displays the streaming image.

Shoot: Displays the static image in the camera’s field of view.

I Note

If the Smart Vision Module (SVM) and the Teach Pandant (TP) connecting the robot and user
draws the cable physically, restart the SVM and TP.

I LAnvEAMO| 2a8oz sym AZo| Zojxl AL

- Smart Vision Module(SVM)Z Teach Pandant(TP)7t @ Z & A= MENOA S2[Xez Mg
&2 4% svmit TP ol S OFF/ON dfioFgtL|Ct.



N uegmA LeD 715

The status indicator LED on the top of SVM module operate in four modes: power supplied,
connection standby, communication connected and processing.

- Smart Vision Module Status Indicator LED LED Operation

1 | Power not connected Power off
2 | Power connected — OS booting Solid Red I
3 Normal . operatlon — Connection standby — Solid Green
Communication not connected
4 Normal operation — Standby - Communication Solid Blue
connected I
5 Normgl operation —.Processmg—(ltem recognition, Blink Blue aEEEE
teaching/save/loading)
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2.2 Vision Job > Manage Job

2.2.1 Create Vision Job

< Servo Off

- Smart Vision Camera Confirm
==

Vision Job

Peripheral

Manage Job >

@) SmartVision Camera

o T & &2
No. Iltem Description
If there is no existing job, create a new job with the job name
1 Add New Visi b “VisiondJob_01,” and if there is an existing job, create a new job
ew Vision Jo with the job name with the following number of the existing job.
(l.e., VisionJob_02)
2 Vision Job List A virtual keyboard is displayed, and the job name can be edited.
3 Save After the job name is edited, save the created job.
4 Cancel Cancels the Vision Job creation.
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222 Edit and Delete Vision Job
< Servooff

Smart Vision Camera Confirm

Vision Job

Peripheral

Manage Job > Set Image >
() Smart Vision Camera

Qe &

&

No. Iltem Description
1 Vision Job List The selected vision job is highlighted in blue.
) The job selected from the Vision Job List is set as the Setting
2 Set This Job .
job.
3 Edit The job selected from the Vision Job List triggers the edit
window where the “Job Name” can be edited.
4 Save Saves the edited vision job name.
5 Delete The job selected from the Vision Job List is deleted.
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2.3 Vision Job > Set Image

2.3.1 Save and Load Lighting/Exposure/Gain/Focus Setting

< Servo Off

17.12.04 1:02:19 PM

[~ ] Smart Vision Camera © Confirm

==

Camera Connection Vision Job
Peripheral =
Manage Job > Set Image > >
Name VisionJob_01 @4 ) | u
4
Shoot Pose a
o5

Home

LED LIGHT | CAMERA BRIGHTNESS
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::i:' |

1

Image Brightness Setting

Displays the LED LIGHT/CAMERA BRIGHTNESS select
button.

Live/Shoot

* Displays the image from the Live/Shoot mode, and the button
changes to gray.

* Live: Displays the Live image of the camera.

» Shoot: Displays the image obtained from the current camera
with edge information.

Apply Reference Image

* Itis enabled in blue in the Shoot mode.

* A Reference Image is the reference information for the Vision
Job setting. Select the item information to detect from the
Reference Image, and then set default values for various tests.
(Setting is made in the Edit Job tab)

* Sets the current camera image as the Reference Image.

» Saves the current camera focus/lighting/brightness
information.

» Saves the current robot Joint Pose as the Shoot Pose.

LED LIGHT

Displays buttons that adjust the brightness of the lighting.

CAMERA BRIGHTNESS

Displays buttons that adjust the Exposure/Gain levels.

Lighting Brightness
Setting

The brightness of the lighting can be adjusted between 0 and
10.

Exposure Time Setting

* The exposure time of the camera can be adjusted between 0
and 10.
» Higher numbers create a brighter image.

Gain Level Setting

* The gain level can be adjusted between 0 and 10.
» Higher numbers increase image brightness, but this also
increases image noise.

Doosan Robotics

Reference Manual v1.4
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g F Control » Camera focus can be adjusted in a range from 0 to 500.

ocus tontro « The focus must be set clearly prior to Robot-Vision Calibration.
10 Auto Focus * The focus of the camera is adjusted automatically.
11 Manual Focus » Camera focus can be adjusted in a range from 0 to 500.
12 Inc * The value changes in the order of 1, 5, 10, 50, and 100.
13 Focus * The focus increases or decreases by the amount of Inc.
14 Full Screen Displays the image in full screen.
15 Grid Displays a grid on the image. Each grid represents 10% of the

ri
screen.

I Camera Brightness Adjustment (Exposure / Gain)

It is recommended to start with Gain set at level 1, adjust the Exposure to set the desired
brightness, and then adjust Gain to make minor adjustments.

A Changing the existing Reference Image will delete the Tool List added in the Edit
Job Tab.

I Conditions for a Good Reference Image

The edge information of the item to detect must be clear.

The size of the item to detect must be within 5%-70% of the overall screen size. It is
recommended to set the size of the item to detect to 20%-40%. Use the grid pattern to check
the size.

The item to detect must be positioned in the center of the screen.
Items/patterns other than the item to detect must not be on the screen.

The background must have a clear difference in color from the item to detect, and it must not
have patterns.

2.3.2 Camera Calibration

Camera - Robot Calibration is the process of synchronizing the coordinate information measured by
the camera with the coordinate information of the robot.

With Calibration, the camera can accurately move to the location of the measured item, and it can
accurately measure dimensions in terms of length. During Calibration, a checkerboard with predefined
design information is used. The method currently offered by Doosan Robotics is StandAlone
calibration, and the elements required for this calibration are four robot poses taught based on the
camera image of the checkerboard shot from the shooting position and tool tip.
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A Caution

During calibration, it is necessary to align the camera lens and the checkerboard in parallel as much
as possible. Also during calibration, the calibration board must placed at the surface height of the item
to be measured when calibration is performed. If the height of the checkerboard during calibration
differs from the surface height of the item to be measured, it can cause failure to detect the item or
decrease measurement accuracy.

I Additional Functions available with SVM

. Live screen is displayed on the Jog

X Jog Ready
2019.03.2111:29:15AM
Real u Robot Workspace | None v ‘ Joint Task
v
:
.
Move Simulator operates only in the virtual mode.
.
:
.
Manual Mode Speed € o o
E CHEE - A
-a D
D T o8 . O
Home Workcell Manager  Task Builder Task Writer Status Jog Setting Power

If the Vision license is entered, a live image can be viewed in the Jog tab. The user can operate the
robot while viewing the live image.

X Jog Ready

2017.1129 1:18:34 PM

Task

Tool

Move irtual mode.

. +

1% 1007

® T =z & Q & & O

Home Workcell Manager ~ Task Builder Task Writer Status Jog Setting Power

Manual Mode Speed @
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Added Vision category to Peripheral

< Ready

2019.03.21 11:24:39 AM

New Peripherals

. Categori T
Peripheral s ee
Feeder Smart Vision Camera
Other

Vision

/] 4]

® T oo CHE S O
0o 0

Home Workcell Manager  Task Builder Task Writer Status Jog Setting Power

I SVM Calibration Board Download

7|1=At= 2

00
@ v Q wew © 00w
300
- SUMHFZHC Base & Flange Robot Model
e Drawing (STEP)
yana

The SVM Calibration Board can be downloaded from [https://lab.doosanrobotics.com/ko/Index
by accessing Robot LAB — Resources — Tech Data — Reference] after logging in.
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https://lab.doosanrobotics.com/ko/Index

Name VisionJob_01
® @ oo IR

Shoot Pose & MoveTo .

Calibration & Alignment

1 )camera Calibration @ \B
®) |
O -« |

Calibration Board Square Size

@ |

@ Robot Coordinate @)
Probe TCP Position
Workcell item v
I
@ [ema .
points (@ ;
ot G .
pointo @ :

Enables Camera - Robot Calibration function.

Camera Calibration * After the Camera Calibration function is enabled, the Camera

Calibration Image button is enabled.
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The Live/Shoot Image can be checked.

To ensure proper camera calibration, a checkerboard is placed
as follows:

* The calibration image provided by Doosan Robotics is a 15 mm
checkerboard. [Download Page]

* Place the checkerboard at a distance of 300 mm~600 mm from
the SVM.

* The checkerboard and the camera must be parallel (less than
1°).

» Use the Grid function of the image to position the checkerboard
as follows:

2 Live/Shoot Image

* Place the center point where the center arrow “O” is pointing on
the red cross at the center of the camera image.

 Align the checkerboard vertically and horizontally along the
green guide lines to prevent rotation.

Adjust the focus, brightness and lighting to display the edge of

Lighting Setting/ the checkerboard clearly.

Save Shoot Image/ . .
3 9 * Press the Shoot button to check edge information.
Shoot Pose * Press the Apply Reference Image button to save the camera
information and Shoot Pose.
Run checkerboard corner point detection.
4 Camera Calibration Image | * Press the View Image button to check the detection results.

« If detection failed, the checkerboard pattern is not displayed on
the View Image button.
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Sets the information of the Tool currently equipped on the robot
as TCP.

* A probe type Tool is recommended. If a gripper is used, it is
recommended to make measurements with a probe-shaped
item grabbed as in the following image:

 For information about measuring the tool center position, refer

| &

5 Load TCP Setting

the User Manual.

Obtains the robot pose [X, v, z, rx, ry, rz] of PointA - PointD.

* If the base plane of the robot and the workspace are on the
same plane, the tool center point of the robot is aligned based
on the base axis. Robot poses corresponding to PointA-PointD
are acquired with the aligned axis unchanged using plane lock
and axis lock of the Constraints Motion button in the robot
cockpit. Refer to Robot User Manual - Jog - Setting Screen -
Align according to Base Axis for how to align the base axis with

. . . the TCP end.
6 Obtain PointA - PointD If the workspace where the target item located is slanted, unlike
Points the base plane of the robot, align the tool center point according

to a virtual vector area. Refer to Robot Manual — Jog — Setting
Screen — Align according to Target Point.
» Perform direct teaching of corner points on the checkerboard in

the order of @, B, © and © with the end of the robot tool to
enter the coordinates of each point.

¢ Tap the Move To button to move to the corresponding point.

* Press the Reset button to reset robot coordinates.

« If the end of the tool fails to accurately pinpoint the corner points
of the checkerboard, point deviation occurs.
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Run the camera - robot coordinate matching calculation.

After calculation is complete, the results are displayed. If
successful, save the Calibration information in the camera.
Success (® success) [ Failure (@ Failure)

Success Criteria
¢ All grid patterns of the checkerboard must be displayed on the image.

« Dark grid patterns of the checkerboard must be positioned on the
top/bottom left.

»  Check whether all corner points are detected using View Image.

* TCP information identical to the information of the tool equipped must
be set.

»  Enter corner points of ABCD of the checkerboard with direct teaching
to the robot.

» Teach the robot tool the exact positions of ABCD corner points of the
checkerboard.

* The checkerboard position must not change during direct teaching.

Failure Criteria
Alignment with Robot

7 . . i
Coordinate If all corner points of the checkerboard are not detected.

» If the direct teaching order of ABCD corner points of the
checkerboard is incorrect.

+ If the set TCP information does not match the information of the Tool
equipped.

« If the direct teaching of corner points of the checkerboard is not
accurate.

» If the ABCD coordinates measured by the camera are different from
the ABCD coordinates taught to the robot by direct teaching (calibration
fails if a deviation of more than 5 mm occurs).

Items to Check Upon Failure

* Check the position/direction of the checkerboard.

» Check whether edges of the checkerboard are clearly displayed.

* Check whether direct teaching was performed in the order of ABCD.
*  Check whether the TCP setting is correct.

* Check whether the checkerboard print was moved after Camera
Calibration Image.

*  Check whether the ABCD corner points of the checkerboard were
taught accurately.
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2.4 Vision Job > Edit Job

2.4.1 Vision Tool Teaching Area Setting

Semart Vision Camera ] Delete Confirm
Vision Job
Peripheral - s
Manage Job > Set Image > Edit Job >

[G) smart Vision Camera Name VisionJob_01 @ I

vision Tool List )

+ Rotation Tolerance (*) 180 /180
Similarity Threshold (%) 50 /100

Edit Position @ @
=

EJ position Name

I VisionJob_01 I

Crop Inspection Area )

Rotation Tolerance (') ©

Similarity Threshold (%) @

@ 50

Advanced Option

Similarity Threshold (%) @ u

o

- Advanced Option
“~+

Edge Intensity @

simplity @
@

Accuracy Level @

® © @

1 Edi The settings popup window for the job selected from the Vision
It Tool List is displayed.
2 Move Teaching Area Press and hold the arrow to move the teaching area.
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(green area) * Press the Apply button to set the selected area.

Adjust Teaching Area Size | Press and hold the arrow to adjust the teaching area size.

(green area) * Press the Apply button to set the selected area.

4 Edit Job Name A virtual keyboard is displayed, and the job name can be edited.

* Press the Apply button to apply the name to the camera.

A window limiting the teaching area is displayed. The set area
5 Crop Inspection Area is...

» saved to the camera when the Apply button is pressed.

Configures the angle tolerance from the reference angle. (input
range: 0~180°)

* Sets the acceptance range for items rotated at an angle
deviating from the Reference Image.

* For example, if the Rotation Tolerance is 180(-180~+180), it
detects items in all rotation angle ranges, and if the Angle
Tolerance is 10(-10~+10), it only detects items rotated within
10" from the Reference Image. Setting a larger Angle
Tolerance value increases detection speed, and a smaller
value decreases detection speed.

* Moving the scroll immediately applies the tolerance.

6 Rotation Tolerance

Configures the similarity threshold from the reference value.
(0~100%)

* Similarity is the level of matching between the edge of the item
image and the edge in the Reference Image.

* The similarity of the item to detect can be set by adjusting the

Similarity Threshold.

For example, if the Similarity Threshold is 50, the system only

detects items matching a Reference Image of 50% or more.

Higher Similarity Threshold values increase the level of

distinguishing similar items, but fail to measure items if there

are items with small changes, camera distortions or light

reflection changes.

Lower Similarity Threshold values allow flexibility in responding

to item/environment changes, but this can cause incorrect

measurements of similar items within the measurement area.

Setting a proper Similarity Threshold to match the measuring

item/environment is crucial to the success of the Vision Job.

* Moving the scroll immediately applies the tolerance.

7 Similarity Threshold

Sets the intensity of edges detected.

* Larger color differences in the area surrounding the edge result
in higher edge intensity, and smaller color differences result in
lower edge intensity.

« If the intensity is set as [+2] from the default [0], only edges with
high intensity appear, and edges with low intensity are
removed. Setting [-2] will display edges with both high and low
intensities.

* Moving the scroll immediately applies the tolerance.

8 Edge Intensity

9 Simplify Clean up edges by simplifying them.
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* Small, noise-like edges among measured edges disturb the
teaching of shapes. Changing the value from 1 to 5 will remove
small edges.

* Larger values remove smaller edges and improve calculation
speed.

* Moving the scroll immediately applies the tolerance.

Adjust the Accuracy Level if you want to detect items more
accurately or faster.

10 Accuracy Level * Larger values improve shape detection accuracy.

* Smaller values improve detection speed, but decrease shape
detection accuracy.

* Moving the scroll immediately applies the tolerance.

11 Apply Applies Vision Job settings.

12 Cancel Cancels Vision Job settings.

Doosan Robotics Reference Manual v1.4 94



2.4.2 Vision Tool Teaching Limit Area Setting

-] Smart Vision Camera Delete Confirm
Vision Job
Peripheral - x
Manage Job > Set Image > Edit Job >
@ Smart Vision Camera Name VisionJob 01 E
Vision Tool List )
+ Rotation Tolerance (*) 180/180
Similarity Threshold (%) 50 /100

Edit Position

S “

B position Name

Py VisionJob_01

;S Crop Inspection Area P I

Rotation Tolerance () @

V. Similarity Threshold (%) @

(] 50

Advanced Option
=

Efit Position @ @
N E
——

B3 position Name

VisionJob_01
Crop Inspection Area

Rotation Tolerance (") @

. 80
L Similarity Threshold (%) @
o, @ 50
C ) Advanced Option
Edge Intensity @
- H

Displays an area setting tool that limits the teaching area.
* The set area is saved by pressing the Apply button.

1 Crop Inspection Area

Move Teaching Limit Area | Press and hold the arrow to move the area.
(red area)

* The set area is saved by pressing the Apply button.
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Adjust Teaching Limit Press and hold the arrow to adjust the size of the area.

3
Area (red area) * The set area is saved by pressing the Apply button.

- Grid Display Displays grids on the image.

Press the briefcase icon to display the Scale/Move selection
window.

* Fine adjustments to the Teaching Area position of the image
can be made with Move.

- Scale/Move * Fine adjustments to the Teaching Area size of the image can
be made with Scale.

* UP/DOWN Scale buttons and UP/DOWN Move buttons are
displayed.

* Select A: Selects the Teaching Area setting.

» Select B: Selects the Teaching Limit Area setting.

4 Apply Applies Vision Job settings.

5 Cancel Cancels Vision Job Tool settings.
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2.4.3 Create Position Tool and Set Teaching Area

The Position Tool is used for measuring the position and angle of an object (shape). Teach the item
(shape) area to measure from the Reference Image, and set related parameters. The Position Tool
measures the amount of rotation(angle) from the center point of the teaching area and the teaching

area.
< Servo Off
2017.1205 1:28:44 AM
Smart Vision Camera [i] Delete © Confirm
Camera Connection Vision Job
Peripheral . .
Manage Job > Set Image > Edit Job >
E] Smart Vision Camera Name VisionJob_01
vision Tool List )
Position (oM -]
+ I:I Rotation Tolerance (°) 180 /180
Similarity Threshold (%) 50 /100
@ (1)
85
Home Status Setting Power
< Servo Off

2017.12.05 1:29:09 AM

Edit Position @
. f

m Position Name

©
H*
-]
a
A *Q @ O
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1 Add Position Tool Adds a Position Tool to the Vision Tool List.
. The settings window for the job selected from the Vision Tool
2 Edit L
List is displayed.
3 Delete The selected job from the Vision Job List is deleted.
4 Move Teaching Area Press and hold the arrow to move the teaching area.

* The set area is saved by pressing the Apply button.

5 Adjust Teaching Area Size Press and hold the arrow to adjust the teaching area size.

* The set area is saved by pressing the Apply button.

Edit Job Name - Edit A virtual keyboard is displayed, and the job name can be edited.

6 '

Window * Press the Apply button to apply the setting.
7 Apply Applies Vision Job settings.
8 Cancel Cancels Vision Job Tool settings.
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2.4.4 Create Presence Tool and Set Teaching Area

The Presence Tool checks the histogram of shapes. The histogram of brightness(level 1-256) of each
pixel in the teaching area is calculated(frequency table) to be used as default information for the
presence check. Set the brightness range corresponding to the shape to check and press the
Calculate button to measure the area of the shape(Pixel Count) by detecting pixels corresponding to
the set brightness range. Adjust the acceptance range(Tolerance) of the check based on measured
area values to set the presence check.

< Ready

2017.1205 1:35:16 AM

Smart Vision Camera (il Delete © Confirm
Camera Connection Vision Job
Peripheral . .
Manage Job > Set Image > Edit Job >
@ Smart Vision Camera Name VisionJob_01
Reglon
VisionTool List )

*

+ Rotation Tolerance (°) 180 /180
I:l Similarity Threshold (%) 50 / 100
= o0 0 (1
{at <+ oo @ O} “o° O
Home Workcell Manager  Task Builder Task Writer Status Jog Setting Power
< Ready

Edit Presence @ @
P

E Presence Name

Presence |

Histogram €@ @ Calculate

Min - Max
()
“ e o
Area ﬂ
oo (1
)
Q E oo “° W
Hode WorkcelManager  Tiskiullder  TaskWeita st Jok e

929



< Servo Off

Edit Presence

Min ~ Max u
Bass Regior

Area Tolerance (Pixel)

79000 |~ 81000 n

o 2 w o

1 Add Presence Tool Adds a Presence Tool to the Vision Tool List.
. A setting window of the job selected from the Vision Tool List is
2 Edit .
displayed.
3 Delete The selected job from the Vision Job List is deleted.
4 Move Teaching Area Press and hold the arrow to move the teaching area.
5 Adjust Teaching Area Size | Press and hold the arrow to adjust the teaching area size.
5 Edit Job Name - Edit A virtual keyboard is displayed, and the job name can be edited.
Window * Press the Apply button to apply the setting.
Checks the histogram distribution of edges within the Presence
7 Calculate .
Tool teaching area.
Slide the horizontal Histogram Min/Max bar to adjust the
detection level of desired edges.
* Presence check uses histogram check. A histogram is list of
the distribution of brightness of pixels within a measurement
area from 0O to 255. If the measurement area is completely
Histogram Min/Max white, the brighter area (255) value in the histogram becomes
8 larger, and if the measurement area is completely black, the

Setting darker area (0) value becomes larger.

* You can adjust the range of pixels to the desired brightness
using the blue button. If the button reaches the end points (0,
255), it obtains all pixel values within the measurement area.

* For example, positioning the blue button between 1 and 2 will
only obtain pixels with brightness corresponding to 1 and 2.

* Pressing the button immediately applies the tolerance.
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Enter the pixel value allowed within the detected area in the edit
window. Values exceeding the entered value range are not

. detected.
Area Tolerance Limit

9 * Area displays the number of pixels corresponding to the

Setting brightness value set using the blue button (0-255).
* If the value exceeds the Area Tolerance range, it considers that
the histogram is not similar, and the measurement fails.
* Press the Apply button to apply the setting.
10 Apply Applies Vision Job settings.
11 Cancel Cancels Vision Job Tool settings.
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2.4.5

Create Distance Tool and Set Teaching Area

The Distance Tool measures the distance between two lines. Place areas A and B on a line you want
to measure and press the Calculate button to measure the distance between A and B. Adjust the
acceptance range (Tolerance) of the check based on measured distance values to set the distance
check. [A—B] measurement refers to the length of the line connecting the center of line Ato line B or
an extension line of line B.

Add Distance

Adds a Distance Tool to the Vision Tool List.

Tool
Edit A setting window of the job selected from the Vision Tool List is
: displayed.
Delete The selected job from the Vision Job List is deleted.

Move Teaching
Area

Press and hold the arrow to move the teaching area.

Adjust Teaching
Area Size

Press and hold the arrow to adjust the teaching area size.

Adjust the area to allow one edge to be captured in it.

Edit Job Name

A virtual keyboard is displayed, and the job name can be edited.
* Press the Apply button to apply the setting.

Select Directions

Select the directions for A > B and B >A.

* Pressing the button immediately applies the direction.
* [A->B] measurement refers to the length of the line connecting the
center of line A to line B or an extension line of line B.

of Line (A, B) —» [ASB]
— «— [BA]
Creates a line that connects the center position of lines A and B
Calculate when lines exist in the two teaching areas (A, B).

* Pressing the button immediately applies the direction.

Distance Display

Enter the pixel value allowed within the detected area in the edit
window. Values exceeding the value range entered are not detected.

Distance

Area displays the number of pixels corresponding to the brightness

Doosan Robotics Reference Manual v1.4
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Tolerance value set using the blue button (0-255).
Setting * If the value exceeds the Area Tolerance range, the inspection result
is 0.
* Press the Apply button to apply the setting.
Apply Applies Vision Job settings.
Cancel Cancels Vision Job Tool settings.

2.4.6 Create Angle Tool and Set Teaching Area

The Angle Tool measures the angle between two lines. Place areas A and B on a line you want to
measure and press the Calculate button to measure the angle between A and B. Adjust the
acceptance range (Tolerance) of the check based on measured angle values to set the angle check.

< Servo Off

[ Delete © Confirm

mera Connection Vision Job

Peripheral

Manage Job® > Setimage® > Edit Job >

[G) smart vision Camera Name VisionJob_01

Vi

Tool List

%o
@ B
L W ¥
+ Rotation Tolerance (") 180 / 180
g Similarity Threshold (%) 50 /100
L)
S
0 ® &
< Servo Off
Edit Angle
=
Angle Name
Angle
e © O -1
Angle Tolerance (°)
1.0 -0
H
]
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Servo Off
< 2011205 101380

Edit Angle

P Angle Name
s © ==
Angle Tolerance (°)
=
B
A @ a3 O
1 Add Angle Tool Adds an Angle Tool to the Vision Tool List.
) Edit The settings window for the job selected from the Vision Tool
! List appears.
3 Delete The selected job from the Vision Job List is deleted.
4 Move Teaching Area Press and hold the arrow to move the teaching area.
5 Adjust Teaching Area Size Press and hold the arrow to adjust the teaching area size.
» Adjust the area to allow one edge to be captured in it.
Adjust Teaching Area Size .
6 : . g Press and hold the arrow to rotate the teaching area.
(circular arrow)
2 Edit Job Name — Edit A virtual keyboard is displayed, and the job name can be edited.
Window * Press the Apply button to apply the setting.
Measures the angle at which the extension lines of each line
8 Calculate . . .
meet when lines exist in the two teaching areas (A, B).
. Displays the angle between lines detected in two teaching areas
9 Angle Display . -
in the edit window.
. Displays the angle between lines detected in two teaching areas
10 Angle Display .
on the image.
Configures the angle tolerance from the reference angle.
11 Angle Tolerance Setting | * If the value exceeds the Area Tolerance range, the inspection
resultis O.
* Press the Apply button to apply the setting.
12 Apply Applies Vision Job settings.
13 Cancel Cancels Vision Job Tool settings.
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2.4.7 Create Diameter Tool and Set Teaching Area

The Diameter Tool measures the diameter and the center point position of the measured circle. Align
the circle center with the center of the circular item, position circle A outside the circular item to be
measured, and position circle B inside the circular item. Press [Calculate] to measure the circle, and
the diameter and center point of the circle are displayed. Adjust the acceptance range (Tolerance) of
the check based on measured diameter values to set the diameter check.

< Ready

2017205 1:1257AM

= Smart Vision Camera i Delete © Confirm

=]

Camera Connection Vision Job
Peripheral . -
Manage Job > Set Image > Edit Job >
[©] smart Vision Camera Name VisionJob_01
Region
VisionTool List )

+ Rotation Tolerance (*) 180 / 180
l:l Similarity Threshold (%) 50 /100
n o= @ @ @ O

K Writer Status

e

i
‘m

< Servo Off
Edit Diameter

Cancel

[E) biameter Name

Diameter
Diameter @ Calculate I
mm

Diameter Tolerance (mm)

-10 10
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< Servo Off

Edit Diameter @ @
o f
Base Reg N

[E) piameter Name

Diameter

Diameter @

Diameter Tolerance (mm)
® 310 - 321

o

H#

1 Add Diameter Tool Adds a Distance Tool to the Vision Tool List.
. A setting window of the job selected from the Vision Tool List is
2 Edit .
displayed.
3 Delete The selected job from the Vision Job List is deleted.
4 Move Teaching Area | Press and hold the arrow to move the teaching area.
Adjust Teaching Area
5 : g Press and hold the arrow to adjust the teaching area size.

Size

Edit Job Name — Edit | A virtual keyboard is displayed, and the job name can be edited.
Window * Press the Apply button to apply the setting.

Detects circles present between two teaching areas (A, B).

Move circle A to be positioned outside the circular item, and move
circle B to be positioned inside the circular item. Place the green
center point in the center of the item. After calculation is performed,
the circle between circle A and B is identified, and its diameter and
center point positions are displayed.

7 Calculate

N/
oY
M
)
0
{0
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Diameter Displa
8 play Displays the diameter of the measured circle in the edit window.
(after #7)
Circle Displa
9 play Displays the measured circle on the image.
(after #7)
Diameter Tolerance Configures the length threshold from the reference length value.
10 Length Setting - Edit | ¢ If the value exceeds the Area Tolerance range, the inspection result
Window is 0. ,
* Press the Apply button to apply the setting.
11 Apply Applies Vision Job settings.
12 Cancel Cancels Vision Job Tool settings.
2.5 Vision Job > Test

Recognition tests for Vision Job, Position Tool, Presence Tool, Distance Tool, Angle Tool and Diameter
Tool can be performed.

Iltem Description

Displays the image from the Live/Shoot mode, and the button
changes to

gray.
The captured image is displayed beneath the Live/Shoot button.

Live/Shoot Mode

If the measurement is successful, the red circle (.) next to the
Name changes to blue (.).

Tap the Confirm button after all tests are complete.
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3. Programming

Adding a Vision Command to the Task Builder will add VisionStart and VisionEnd.

Adding a Vision Command in the Task Writer will add Vision and End Vision.

3.1 Vision Command Setting Options

The Vision Job List configured in the Workcell Manager displays the
image of the Vision Job selected from the popup list.

Select Vision * Selecting a Vision Job using Select Vision Job enables Vision-
Job related functions.
¢ The Vision Variables of Tools included in the Vision Job can be
obtained.

¢ A Vision Job can be selected.

Move To Shoot Move to the Shoot Pose of the job selected with Select Vision Job.

Pose * Disabling this option means that the Shoot Pose configured for the
Vision Job will not be used.

Display Image | Defaultimage, Live image and Shoot image are displayed.

Tap the Live button to display the live image.
Live/

Shoot Tap the Shoot button to display the test result image.

¢ Obtains data of the Vision Tool added to the Vision Job with the
Workcell Manager, and adds it to the Vision Variable list.
* Live mode ends after 5 minutes of no action.

- . Displays the data list of the Vision Tools added to the Vision Job.
Vision Variable

¢ Press each item to view the values of the current Tool.

Select an action if Vision measurement fails.

Retry: Set the number of Retry attempts if measurement fails. (Initial

Advanced measurement + up to three retry attempts)
Option > Vision
Exception Skip Vision: Skips the failed measurement stage and retries
measurements according to the number of Retry attempts.
Stop Task: Stops the Vision Task if measurement fails.
3.2 Task Builder: Using Vision in Skill Commands
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= Task_20190412_161517 Res

2019.04.12 4:17:39 PM

Tools Task List Command Property Play
. 0oL
@ |™ oo pick
Multi-Select
002
[j u MainSub (Task Vel. 250.0, Acc. 1.0, Jo Pneumatic Gripper
Copy 003
Grasp Release
ks ‘
cu o % : | ‘ Picking Pose ® >
005 ioi (
ff:
Vidontind Vision Position Offset o k)
j 006 Vision Job
N H EndMainSub
Delete
= Vision Variable
Row Up
=l
Lol Advanced Option 3
® T = E & e & O
-l o
Home Workeell Manager  Task Builder Task Writer Status Jog Setting Pawer
— Task_20190412_161517 Ready
- 2019.04.12 4:17:53 PM
Tools Task List Command Property Play
oo1
2 pik =
Multi-Select
SN
T H MainSub ( Task Vel. 250.0, Acc. 1.0, Jo-- o T
Copy 00
R Picking Pose ® >
0%
Cut
‘ F Gj Vision Position Offset ) L) |
005
VisionEnd Vision Job

E] 006
ﬂ EndMainSub
Delete

Vision Variable

VisionJob_01_pose

.
B A
5

=l Advanced Option ¥
R T = B & e B O
No. Item Description
Enter the desired robot position.
Inserting a Skill Command (Pick, Place, etc.) between VisionStart
and VisionEnd in the Task List will create the toggle button for the
Add Skill Command after skill command to Vision Position Offset. (The button is not
1 Vision Shoot and before displayed if there is no Skill Command between VisionStart and
Teaching Position Entry VisionEnd.)
Caution: To use Vision Position Offset, it is necessary to perform
calibration in the Workcell Manager. The robot cannot move to the
desired position without calibration.
2 Vision Position Offset Match the Vision measurement pose and robot pose.
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The Vision measurement pose can be moved based on the robot.

3 Vision Variable Select a pose to match the Vision and robot coordinates.

3.3 Task Writer: Using Vision in Motion Commands

= Task_20181116_203935 Ready
20181116 8:46:08 PM
Tools Task List Command Property Play
%L Globalvariables Move L (Linear)
Multi-Select |~ 002 CustomCode
In} o MainSub | Task e Ace. 1 visl

Copy 004

vision )
i oo ° Move L Coordinate BASE .
cut w
2 ) =Ll (B | Absolute Relative
007

008

End Vision Select Variable v
(i o EndMainSub + ] )
o @ GetPose H * Move To ) Reset
= X 288.75 v 424.09mm|| 2 5807m
Row Up
. A 13343 B -174.87 c -174.57
Row Down
2 B & & @
a oD
A T 5o = 0 O
Home Workcell Manager  Task Builder Task Writer Status Jog Setting Power
= Task_20171128_134538 sevoOff
- 017.11 28 2:03:32 P
Tools Task List Command Property Play
= 001
Multi-Sebect | 002 CustomCod
ustomtode Blending mode ® Duplicate Override
| b Mainsub
Copy 004 .
Vision Advanced Optien 2
[ s Move L
cut =
|_ MoveL (v @ [ vision Position offset @ )
007
Vision Jobs
becd End Vision
0 [ R

Vision Variable

| Vishonlob_01_pose A
Vision Variable

Visionlob_01_pose

Description

1 Add Motion Command

Enter the desired robot position with Move L.
after Vision Shoot and
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before Teaching Position
Entry

If you insert a Motion Command (Move L, Move B, etc.) between

Vision and End Vision in the Task List, the toggle button for

Vision Position Offset will appear as shown in @ in the last line

Add Motion Command for | of Move L. (The button is not displayed if there is no Motion
Vision Offset Pose Command between Vision and End Vision.)

Caution: To use Vision Position Offset, it is necessary to
perform calibration in the Workcell Manager. Without calibration,
the robot cannot be moved to a desired position.

Match the Vision measurement pose and robot pose.
3 Vision Position Offset o
Vision measurement pose can be moved based on the robot.

4 Vision Variable Select a pose to match the Vision and robot coordinates.
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4.1

4.2

4.3

Product Specification

Dimensions (W x D x H) 92 mm X 132 mm X 25.6 mm

Weight 348 ¢g

Resolution CMOS 2.5 M pixel (1920 X 1440)

Camera Manual Focus

Brightness White LED X 2 EA (800Lux@WD500 mm)

Communication TCP/IP, 100 Mbps

Power  24W (24V, 1A)

Measurement Distance

The camera measurement area varies according to the distance from the camera. The measurement
area of the camera according to distance is as follows: If the distance is shorter than the
recommended distance or the camera is outside the measurement area, the measurement accuracy
will decrease or there may be misrecognition. When used in areas outside the measurement areas
below, configure the work area after performing a sufficient number of tests.

Distance from the Camera (mm) 300 400 500 600
Measurement Are W (Horizontal) 300 396 494 593
a D (Vertical) 220 293 367 440

Length / 1pixel (mm) 0.19 0.25 0.319 0.384

Size and Height of Measuring Iltems

The size of items to measure is limited by the size of the measurement area according to distance,
and the system recognizes items with a size from 10% to 70% of the measurement area.

Distance from the Camera (mm) 300 400 500 600
Size of Item Min. (WxH) 30x22 40x29 49x37 59x44
Max. (WxH) 180x130 238x176 296x220 356x264

Max. Height of Item 22 29 37 44

All 2D Visions, including Vision by Doosan Robotics, can have misrecognition due to distortions
created by perspective view. The maximum height of the item to be measured is recommended to not
exceed the smallest surface dimension. Even if the measurement height is misrecognitionlower than
the maximum height, s can still occur due to perspective views created according to the camera view,
and if the view is close to Top View, misrecognitions can be minimized even if the measurement height
is higher than the maximum height.

Measuring Item and Background

Light reflected by surfaces of the measuring item or the background can cause misrecognition and
hinder measurement accuracy. Also, if the measuring item and background have similar colors, this
can also cause misrecognition and hinder measurement accuracy.



Part 4
Conveyor Tracking



S.

Precautions before Use

Currently, only the Linear Conveyor is supported.
One robot can support up to two conveyors.

When connecting one conveyor, it is necessary to have one encoder, which can measure the
traveling distance of the conveyor, and one triggering switch, which detects objects passing
through a particular starting point.

The encoder signal and triggering switch can only be used in one robot. In other words, one
conveyor cannot be connected to more than two robots.

The encoder and triggering switch are connected to the encoder terminals (TBEN1, TBEN2) of
the control box. Connect the encoder with A phase or A/B phase depending on the specification,
and connect the triggering switch to S phase. For details about sensor selection and connection,
refer to Installation Manual 4.2.6.

The encoder resolution is selected based on considerations made on the resolution of the
encoder itself and every reduction ratio from encoder input up to workpiece traveling mechanism.
Select an encoder resolution that allows the entire system resolution to be at least 5000 count/m.

If the entire system resolution is greater than 10000 count/m, there is no point in upgrading
system performance.

Conveyor speed of 10-500 mm/s is supported.

All task motions are supported during conveyor tracking. However, Absolute motion only allows
Base, World and Conveyor Coordinates, and Relative motion allows all.

The Compliance Control command can be executed during conveyor tracking.
In the current version, the Force Control command cannot be executed during conveyor tracking.

The Set Tool Weight command is allowed, but the Set Tool Center Position command is not
allowed during conveyor tracking.



6.

6.1

Setting with Workcell Manager (WCI)

Set the External Encoder first, then check the Input Signal, and set the Conveyor Tracker.

External Encoder Setting

The External Encoder sets the Encoder Channel according to the encoder connection, sets A-B Phase
according to the encoder specification, and sets S Phase Mode according to the triggering switch
sensor specification and configuration. For details of each setting, refer to User Manual 7.7.

6.1.1 Encoder Installation and A-B Phase Setting Check

To check whether encoder installation and A-B Phase settings are correct, check whether the Encoder
Count of the Input Signal increases or decreases according to the setting by operating the conveyor.

6.1.2 Triggering Switch Installation and S Phase Setting Check

6.2

Whether triggering switch sensor installation and S Phase setting are correct can be checked in the
settings of the External Encoder. Set S Phase Mode as Count Clear Mode and allow workpieces to
pass through the triggering switch, and see whether the Encoder Count is cleared as 0 or whether the
Encoder Strobe Count increases by the set Edge amount.

If triggering switch connection is incorrect or if noise is present, Encoder Strobe Count functions
abnormally. Debug hardware connection and configuration while monitoring the trend.

Once the check is complete, make sure to set S Phase Mode to Signal Mode to ensure proper
connection with the conveyor.

Conveyor Tracker Setting

The Conveyor Tracker is set in a sequential order of Interface > Coordinates > Speed tab. For basic
settings, refer to User Manual 7.7. This section only describes noteworthy items in each tab.

6.2.1 Interface Setting

Triggering Mute Time is used when the noise in the triggering switch sensor is at an acceptable level.
For example, when a workpiece passes through the triggering switch, there are cases where an edge
is detected, but additional samples of the edge may be detected within a short period of time after
detection due to the electric noise generated during signal switching. In such cases, set the Mute Time
to allow the first edge detected to be recognized as a workpiece and subsequent edge detections
within the time to be ignored. This setting is used when the workpiece interval can be estimated and
electrical noise cannot be controlled due to poor work environment conditions.
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Conveyor Tracker [il Delete © Confirm
L . L] L ]
Interface > Coordinates > Speed
Conveyor Type  Linear
External Encoder Input
Encoder Workcell Item | External Encoder v
Triggering Mute Time 0.0 sec
6.2.2 Coordinates Setting
Conveyor Tracker | Delete ) Confirm
ey of ©
== )
Interface” > Coordinates >
Peripheral
Conveyor Teaching Points o
Pneumatic Gripper
m PP Coordinates World v
& conveyor Tracker (:) (:) (:)
_ Point X1 Get Pose ®Move To Pose Reset -
®.- 1 1000000000000
X +3333.330m ¥ +3333.33 +123.00mm A +60° B 60" | C +60
Point X2 Get Pose Move To Pose Reset -
E2 1000000000000
¥ +333333 ¥ +3333.33 +123.00 @ +60 B +60 ( +60
Point X3 L Get Pose Move To Pose Reset v
Point X4 Get Pose Move To Pose Reset v
Point ¥ Get Pose Move To Pose Reset a
¥ +3333.33 Y +3333.33 +123.00 +60° B +60° ¢ +60

Conveyor Detailed Settings” @)

@

Count [ Distance
@Conueyor Coordinates

X +3333.33 ¥ +3333.33

50000000 count/m

+123.00 +60° B +60° | € +60

The purpose of the Coordinates tab is to set the Count/Distance value and Conveyor Coordinates of
Conveyor Detailed Settings. It calculates the converted value, which indicates how much the Encoder
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Count increases when the conveyor moves, and which point the conveyor is fixed to in a particular
space. The x-axis of the Conveyor Coordinates is the direction the conveyor moves in terms of the
reference coordinates (Base or World).

Z Triggering Switch

Conveyor &
Coordinates '
1-/_" X

Methods to calculate these values are Auto Measure after teaching the Conveyor Teaching Point to the
robot and Manual calculation from the system design specification. Auto Measure is recommended for
the purpose of reducing errors, but Manual calculation is possible of it is difficult to teach the robot of
the workpiece.

Auto Measure

Conveyor Teaching Points

Triggering Switch

Y I ®Y
X l i

® :

X1 X2 X3 X4 |

Workpiece:  TTTommmmmmmmmmmommmmeoes

L J
G

Optional

Place a workpiece on the conveyor in the same way it would be during actual work. Operate the
conveyor and stop the conveyor as soon as the workpiece passes the triggering switch of the conveyor.
Teach the reference point of the workpiece at this moment, and acquire the location of Point X1 using
Get Pose.

Operate the conveyor again and stop it to acquire the location of Point X2 in the same way. Point X is
used to calculate the x-axis of the Conveyor Coordinates. While it is sufficient for X1 and X2, up to four
points can undergo teaching to improve accuracy. Depending on the number of teachings, spread the
position within the range the robot can undergo teaching.

Point Y is used to calculate the y-axis of Conveyor Coordinates, so it is acquired by teaching a
workpiece placed on an X-Y plane to generate a y-axis in addition to Point X.

Acquire a teaching point and press Auto Measure to automatically calculate the Conveyor Detailed
Settings.

Manual Setting

Workpiece location is calculated by applying the Encoder Count increasing in the direction of x on the
Conveyor Coordinates when the workpiece passes the triggering switch. The setting is set based on
the triggering switch, conveyor position and workpiece reference point, and even in situations where it
is difficult to identify the exact position, setting the correct x-axis direction of Conveyor Coordinates will
allow the remaining offset to be accurately entered in the Task Motion of TB/TW, so it is acceptable to
not enter the exact value.
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Triggering Switch

Workpiece Coord.

X-axis

d=e/count_per_dist £

d: distance from conv_coord to workpiece
e: incremental encoder value after triggering switch activated

Count/Distance are Conveyor Tracking commands in TB/TW, and entering the Wait command without
Task Motion will result in tracking of conveyor movement from the current position. The user can adjust
it while monitoring the speed trends. If the robot moves slower than the conveyor, reduce the
Count/Distance, and if the robot moves faster, increase the Count/Distance.

6.2.3 Speed Setting

Filter Size is the conveyor speed filter size. An intuitive Moving Average Filter is used, so increase the
filter value if vibration is present in the robot and reduce the value if tracking performance in the
conveyor acceleration section is low.

Measure Nominal Speed using the Auto Measure button while operating the conveyor. If the conveyor
speed is 200% higher than Nominal, it is used to provide information. It does not require an accurate
value, so it is acceptable to enter a design specification value without actual measuring.

Triggering Switch

; Watch Tracking Out-Tracking
X Window Zone Distance

—

Min. Distance

Max. Distance

The Watch Window in the Conveyor Section is the area that determines work candidates. Workpieces
in this area can only be targets once the work begins. The work itself can begin with the Watch
Window, but in the worst case, this can cause workpiece at the end of the Watch Window to be a
target, so it is recommended to adjust the Watch Window size to allow all work in the Tracking Zone to
be completed.
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1.

7.1

7.2

Programming (TB/TW)

Programming of Conveyor Tracking is made with the Conveyor Coordinates command and Conveyor
Tracking command in TB/TW. Coordinates information of the workpiece is obtained through the
Conveyor Coordinates command, and Conveyor Tracking motion is performed with the Conveyor
Tracking command.

Conveyor Coordinates

For basic a description of the command, refer to User Manual 7.7. This command returns the
coordinates information of a workpiece in the Watch Window at the time the command is executed
according to its Picking Rule. If there is no workpiece in the Watch Window, the command stands by,
but it only remains on standby for the time set by Time Out. (If Time Out = 0, it remains on standby
indefinitely)

Triggering Switch

: Watch Tracking Out-Tracking
X Window Zone Distance

Min. Distance

Max. Distance

Object Offset Coordinates is used to give an offset to the reference coordinates of a workpiece.
Update the program with Pose Variable, which is used to give a static offset, when necessary, and
Pos(x) Variable, which is used to dynamically change the offset.

Conveyor Tracking

Inserting the Conveyor Tracking command in the programming creates the Conveyor Tracking node
and End Conveyor Tracking node. At this time, the robot performs the Conveyor Tracking motion. It is
possible to insert the Wait command to check whether Tracking is performing well, or insert various
other Task Motion commands to develop the desired work.

Also, it is possible to obtain a teaching point for using Task Motion. The teaching point of Conveyor
Tracking must be entered based on the workpiece coordinates, so in order to obtain the accurate
teaching point, the coordinates must be entered manually based on CAD information or be obtained
through the following procedure:

- Select the Conveyor Coordinates to track in the Conveyor Tracking command Property
window.

- With the Start button pressed, let workpieces flow through like an actual workflow.

- When a workpiece enters the Watch Window, a green indicator lights goes on at Get Pose
Ready, and after the indicator light goes on, stop the conveyor in a position where the robot
can perform teaching properly. If the green indicator light does not go on, press Stop and
repeat the process starting from #2.

- After teaching the robot based on a workpiece at stop, press Get Pose to obtain as many
teaching points as necessary. (up to 20 points)

Teaching points can be loaded by Task motion between Conveyor Tracking commands by referring to
the Pose Variable name.

119



In addition to workpiece coordinates, the teaching point supports teaching points in Base or World
Coordinates, and in order to use them, it is necessary to obtain the teaching points of the
corresponding coordinates in the Task Motion Property window.
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8. Other Items to Note

Here are the program templates commonly used.

8.1 Pick & Place (One Conveyor)

This example picks a workpiece moving on one conveyor and places it outside the conveyor. Perform
teaching of ApproachPose and PickPose at Conveyor Tracking Property.

Task List Command Property Variable Play
et Repeat (count, Coun Conveyor Tracking
o0 Movel {Ready) STart 1eacning
ooe Conveyor Coordinates ( Conveyor Tracker, Coord1 Get Pose Ready
007 B —
Conveyor Tracking ( Coordl ) | ‘ Start ]
496 MovelL (Approach Pose
009 , Pose Variable
MoveL (Pick
eA% Comment (Pick...) e ApproachPose
D MovelL (Retract Pose >
) ‘@ Get Pose“f, MoveTo” O ‘ a
End Conveyor Tracking —
0 Movel (Place Pose) e PickPose
0.8 Comment (Place.. -
GetPose|| ¥ MoveTo] A
s EndRepeat {© H = ‘ O ‘

A

By selecting Conveyor Coordinates (Coord1 in the example) as the coordinates at MoveL in the
Conveyor Tracking node, it is possible view teaching points that underwent teaching at Conveyor
Tracking. Select a teaching point (ApproachPose, PickPose) to complete programming.

Task List Command Property Variable Play
L Repeat ‘ Move L (Linear)
e Move L
006 . Approach Pose

Conveyor Coordinates

007 =
Conveyor Tracking X
Coordinates Coordl v
008
Movel (Ap h Pose I
909 Move L K Absolute Relative
920 Comment
ApproachPose v
Si Move L -
¥ MoveT
St End Conveyor Tracking & HOve:10 O Reset
013
Move L - - .
on Comment
015 A B C

EndRepeat



8.2 Pick & Place (One Conveyor)

This example picks a workpiece moving on one conveyor and places it on another conveyor. While the
method is identical to the example in 4.1, it requires two pairs of Conveyor Coordinates and Conveyor
Tracking commands, and each must be programmed at different conveyors.

Task List Command Property Variable Play
003 MainSub (Task Vel. 250.0, Acc. 1.000 Conveyor Coordinates
s Repeat . A
Specify the detailed settings to get conveyor coordinates.

005 |

Move L (Read
006 ; . ) Conveyor Tracker Workcell Item

Conveyor Coordinates [ Convey rac 1, Coordl
Ll Conveyor Tracking ‘ Conveyor Tracker 2 ¥
0a8 Move L y
009 Conveyor Coordinates Name

End Conveyor Tracking
040 Conveyor Coordinates (Conveyor Tracker 2, Coord? | £oprd2
gLt Conveyor Tracking d2 . L~
012 Time Out b

MovelL (Placel
S End Conveyor Tracking
014
EndRepeat i
. Picking Rule
ns
8.3 Multiple Workpiece Handling

This example handles workpieces continuously supplied by one conveyor. If a workpiece is handled
between Conveyor Tracking and End Conveyor Tracking, and if the overall work time is not sufficient,
obtain Conveyor Coordinates information rather than performing End Conveyor Tracking to continue

the work.
Task List Command Property Variable Play

i GlobalVariables Force Control Command
002

CustomCode Compliance 0 Force 0
o MainSub 1
004 . ) Other Command

Repeat tl
005 Movél. (Read Comment © customCode [
odo c Coordinates (Conveyor Tra Coord
onveyor Coordinates .0 (S Ker i, Loo Define o Popup o
001 Conveyor Tracking
008 Set o Weight Measure 6
Move L (Do Something on First kpie
009 S - s - . < 3
Conveyor Coordinates | Conveyo acker 1, Coord? Wait Motion 0
230 Movel (Do Somethingon Secon
e Advanced Command
End Conveyor Tracking
012 Hand Guide Conveyor Coordinate
EndRepeat

Note that it is necessary to differentiate the first coordinates and the second coordinates when
teaching. Select coordinates suited for the workpiece, perform Start Teaching, and perform Get Pose
to obtain teaching points suited for each coordinate. If the workpiece is identical, it is acceptable to
share identical teaching points.
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Coord2 v ‘

Start Teaching

Get Pose Ready

‘ Start
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Pose Variable

Q FirstWorkpiece
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